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Notice of Rights

No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language or computer language, in any form or by any
means, electronic, mechanical, magnetic, optical, chemical, manual, or otherwise, without
the prior written permission of T3RRA Pty Ltd.

Trademark Notice

T3RRA™ T3RRA Cutta™ T3RRA Plane™™, T3RRA Ditch™, T3RRA Survey™, and T3RRA
Design'™ software images and their logos are the exclusive trademarks of T3RRA. All other
trademarks, service marks, software images and logos used in this documentation belong
to their respective owners.

Notice of Liability

The information in this document is distributed on an “as is” basis, without warranty. While
every precaution has been taken in the preparation of this course, neither the authors nor
T3RRA shall have any liability to any person or entity with respect to any loss or damage
caused or alleged to be caused directly or indirectly by the instructions contained in this
book or by the computer software and hardware products described in it.

Disclaimer

We make a sincere effort to ensure the accuracy of the material described herein; however,
T3RRA makes no warranty, expressed or implied, with respect to the quality, correctness,
reliability, accuracy, or freedom from error of this document or the products it describes.
Data used in examples and sample data files are intended to be fictional. Any resemblance
to real persons or companies is entirely coincidental.

All information in this manual was correct at the time of writing. T3RRA reserves the right to
make corrections to the courseware at any time and without notification.
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Manual Update Log
November 2020 Beta 0.2 o Rearranged chapters
e Updated tool information
o Added new contour features
June 2021 1.0 (v2.22) | Many updates
July 2021 11 (v2.2]) Added Layer menu options

Added importing files

Added exporting control files
Added keyboard shortcuts
Updated Troubleshooting

Updated Expand/Contract Surface
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Introduction

Hil Welcome to our manual. We're kind of excited to have a manual, because for the longest
time we haven't. There have been exetses reasons for this:

We'd rather put effort into writing software than books.

We update functionality so quickly that a manual is almost always out of date
Our service and support network has always been really good at educating users
Our software is kind of simple and intuitive anyway

Maybe there is some merit in the above. Maybe there isn't. In any case, our latest iteration of
software has significantly raised the bar vis-a-vis functionality and capability. That's
brilliant, but it also means that the complexity has also increased significantly. Regretfully,

we've realized that there is no way around just sucking it up and getting a bit serious about
documentation.

S0 there you go.
And here it is.
Enjoy!

Stu Pocknee
Special Counsel to The Royal Commission Into Making Our Software More Awesome!

" This commission is possibly not officially sanctioned by any particular Royalness and may, or may not bear
resemblance to any commision living or deceased.
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Disclaimer

Important: Please read this before using any of our software products.
We at T3RRA are software developers. We are not irrigation engineers or designers.

We build tools. We do NOT create designs for customers, or provide advice on any
aspect of agronomy, irrigation, drainage, landforming or earthworks design. We
cannot (and do not) warrant or guarantee the appropriateness of any
design created with our software for any purpose.

It is your responsibility to evaluate the fitness and correctness of the designs created in
our software for your purposes. This includes meeting all local rules, regulations,
requirements and laws.

Do NOT blindly follow the output of this software. Monitor work progress and evaluate
the correctness of implementation continuously. Independently verify that the
evolving job is meeting your exact requirements. Any perceived deviation, real or
imagined, must be taken seriously and work must cease until you are satisfied that
the results are within your tolerable margins of error. Seek professional advice from
qualified and certified engineering personnel if you have any doubts about the
correctness of suitability of your design.

Use of our software constitutes an implicit agreement that we and our partners (dealers,
distributors, representatives, business associates, etc) will not be held responsible
for any damages resulting from the use of our software.
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What is TSRRA Design?

T3RRA Design is a suite of software tools for designing agriculturally focused earthworks. It
contains a number of tools that enable sophisticated earthwork design and automated control.
These functions offer full design options combined with many CAD drawing capabilities.
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Installation

To install T3RRA Design onto your desktop or laptop you will need your username and
password, which will be supplied to you by your dealer

To download the Installer, go to users.t3rra.com and enter your -~
credentials. This will launch the Installer. o0 nest t purchece KA Do,

contact us (t3rra.com) or your local
:r dealer E

Once T3RRA Design is installed, you will see this pop up window. — ucense r3aa pesion
Enter your credentials, which would have been provided by @ Hememeand Fessverd
your dealer (these are the same used to login to

Username

users.t3rra.com) Password
t [] Remember details T
NOTE: T3RRA Design can be installed on two (2) devices, using ="
the same credentials.

Antivirus software sometimes prevents T3RRA Design from running or updating. If you have
any trouble running T3RRA Design and have custom antivirus software installed, you can
add an exclusion for the T3RRA Design folder. For more information, see Software fails to

start in Troubleshooting.
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Updating your Software

There are three options for updating your software which will ensure T3RRA Design stays
updated.

NOTE: You will need to restart your T3RRA Design program for updates to take effect.

e s . Toupdate your T3RRA Design software, go to the
i File Menu in the top left of the screen:

= .. Option One (recommended)

| Select ‘Auto-Update’ - this will automatically
update your software when updates become
available.

Option Two

Select “Early Access’ - this will automatically update your software to the latest code which is
available.

Note: Be aware that this will be test code and is subject to bugs.

Option Three

Click on the ‘Check For Updates’ - this will run a check at that point in time and will not
automatically update without your knowledge.

Reverting back to a previous version

There is a provision to revert updates if needed. This is not a process that should normally be
necessary, or that is recommended to be performed by customers. Please contact T3RRA
or your dealer for information about this.
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What's on the Screen

The screen for T3RRA Design can be broken into 3 main sections:

: T Surtace Selec s Tools Help N
T 4 N - L GRLY Lo Visvakaation 7 £ SufaceDesign 5, =4 A 9 o 2 HN T L e ST g &= |
|L“§:“‘.-"L5 75 u@fﬁ i n;m_fﬂ&"n_im\s = @ i -"v“—"f—'g‘-g’;'-nf'---"vlwﬂrmls- 999‘”%"5%-5 |
[Teoom | Gode B
Surfaces (2) | Boundanes (1)
Layer  Select  Visibiity
W Blevations Con'Ii_
Activate layes
!
1 D
Vs
] Blevations Ix'
v‘m'

1. The "Working Area’. Elevation surfaces, designs and surface overlays are displayed in this
area.

2. Layer selection panel. This panel displays the layers of a project and will tailor the available
tools in the toolbar (section 3) for each layer type (surfaces, boundaries, regions, guides).

3. Menus and Toolbar. The menus provide advanced tools and options to adjust how T3RRA
Design operates. The tools that are currently available change depending on the layer type
chosen in the layer selection panel (section 2).

Note: Tools that can be used on all layer types need to be reselected when the layer
selection changes.
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The Working Area

‘The Working Area’ of T3RRA Design displays the topmost selected layer from each of the
different layer types in the layer selection panel.

To keep your design from getting cluttered, turn some layers off. You can do this on the right
by clearing the checkboxes on unwanted layers or dragging the visibility adjuster for each
individual layer.

When T3RRA Design is first opened, the working area will display a notice that there are no
active layers and that you should activate some. It will also show where you can find more
information about T3RRA Design, including current news and tips.

T3RRA Design

On the other hand, you have different fingers,
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When you do create or import an active layer, there are some additional areas of information to
make note of which may be helpful

File Edil Surface Selections  Layers Took  Halp

oy A by (BB e - —t_| o ey i > Visualzation 5 2= iSurface Design — NS s 2N : :Drainage =3

b S~ e di}Q'V*‘.--- @r:H;FE': gb_.-’Took oV B e ESERLIRX '_vl‘_;_'l'ods' »_i
Regions Guides
Surfaces (1) | Boundaries

D lawer Seleq  Visibility

- .
I.“Jwa |

i Il Vibility: ~

5]

Lom: Lat: Elevations

149.113112 27297446 534m

1. Shows the latitude and longitude of the position of your mouse. If your mouse is over a
surface, the elevation height will also be displayed.
2. Displays a time stamp of the last action taken on T3RRA Design.
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Regions Guides (5)

Layer type Selection

On the right side of the screen is the layer type selection panel. This panel || ™™ i‘
allows you to select any layer to view it in the working area, as well as

change which layers are currently visible. Four different types of layers ‘ i D |
are available: vis N |

o Surfaces [ mermncre. g
e Boundaries ‘
[
[

Regions ]
Guides ™.

Each layer type has specific tools relating to them, which can be found in
two separate places. Firstly, the tools displayed in the toolbar will
update and change to match the selected layer type.

Secondly, located under the tab there are three other menu options:
Layer, Select and Visibility.

The Layer menu offers various tools and changes depending on the layer type selected. See
more here.

The Select and Visibility menus have similar options for each layer type, these are:

Regions Guides (4) SB'BCt MeﬂUZ )
Surfaces (2) | Boundaries (1) e All-selects all I|sted_|ayers.
Layer | Select | Visibility o None - deselects all listed layers. |
Sl A o Active - selects all layers which are active
| | None (checkbox selected). | o
Active o Inactive - selects all layers which are inactive
et (checkbox not selected)..
Invert e [nvert - selects just the layers that are not
. | selected.
Visibility Me_’"_“ | | B — i
o Al Visible - will make all listed layers visible Surfaces (2) | Boundaries (1)

o AllInvisible - will make all listed layers invisible

Layer Select | Visibility |
Note: The toggle bar on each individual listed

All Visible
qugr square can be used to make layers Ay
visible/invisible also =
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:Surface Design , e SN\ A Bie -+ ‘Drainage === 2= 9,99 - A -
e 2oL s Nl 0 0 ke g s i,

The tools specific to surfaces fall into three main groups:

e Surface design
e Drainage
e Surface Derivatives

Surfaces are the primary layer type for work in T3RRA Design, however many of the surface
tools are dependent on other layer types being present. For example, the surface design
tools require a boundary to be present.

These are explained in more detail in Surface Tools

Boundaries

%Boundaries.’D*- i Ey; ijl //,/// D@ >

The toolbars specifically for Boundaries are:
e Boundaries

T3RRA Design boundaries are used to limit the extent of a design. They are different to regions
in that they typically outling the entire project area.

After a surface is imported into T3RRA Design, a boundary will need to be either imported or
created to tell T3RRA Design where the desired edges of the surface are.

These are explained in more detail in Boundary Tools

Regions

gﬂegions:D'F L«’f ‘ }

The toolbar specifically for Regions are:

e Regions

Regions in T3RRA Design are flexible and easy to place. Non-linear shaped regions can be
easily made by using the point-to-point creation tool or the line split tool. Regions can be
used to split a design surface into many sub-surfaces, allowing the user to easily modify
multiple parts of the surface independently.

These are explained in more detail in Region Tools
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Guides

cues [ U B Q= [ YERIIR AN

The toolbars specifically for Guides are:

e (uides

Guides are typically used as visual markers and aids when designing. The guides are powerful
when visualising and planning the project and can be leveraged to design from and modify
the surfaces with many of the tools available. It is possible to add:

e Labels at specific points, useful as benchmarks and references
e Straight and segmented lines, and AB lines
e Polygons to indicate specific areas (however, use regions to design in specific
areas)
e Strips
e (ircles
These are explained in more detail in Guide Tools
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Menus

The menus, which are located on the top left hand side for the T3RRA Design screen, include
many options which you would expect to find in a File or Edit menu. It also includes some
T3RRA exclusive options. These are all listed below.

In addition, there are some very helpful Keyboard Shortcuts to compliment the menu options
and also to add to the ease and efficiency of T3RRA Design.

Keyhoard Shortcuts
Keypad Keys Function
Exits or closes any tool/pop up window and returns you
ESC to ‘the pointer tool’
Copy
Citrl +
Paste
Ctrl +

Open new project

Save project

Open/load existing project
Ctrl

+

Print project

+

HEE D EE

Ctrl

]| | | & @
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Ctrl l +

Undo

Cirl l +

Redo

Altl+

Open File menu

Replace ‘F’ with the following to open other menus:
'’ (Edit), S’ (Surface Selections), 'L (Layers), T
(Tools), H (Help)

File Menu
Under the File tab you will find the following options:

New Project - Create
a new blank project.
Save Project - Save
your project. If it is
the first time saving,
you will be prompted
to select a location
and file name.

Save Project As -
Either rename an
existing project or
save a replica project

in a different location.

Load Project - Load a

File | Edit Surface Selections Layers Tools Help

New Project Ctrl+N
Save Project Ctrl+5
Save Project As...

Load Project Ctrl+0
Import Layers From Project...

Finalize Project

Print Ctrl+P
Check For Updates d Early Access)

Auto-Update

Manage auto-saved backups
Export to... 2
Export all active layers to KML

previously saved project .pctgdp or .project.
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Import Layers from project - Allows you to import numerous oo
or single layers from previous projects: v

o Select the project that you would like to import layers
from.

o This window will pop up on screen (see below),
allowing you to manually select which layers you want
to import. You can also “Select All’ or “Select None’

o Once your selection is correct, press ‘Import’.

Finalize Project - Lock project so no edits can be made. You won't be able to save this
project again without giving it a new name.

Print - Opens a print preview window from which you can print the project.

Note: When printing to PDF, we recommend using the built in Microsoft Print to PDF. Some
other print-to-PDF tools produce unexpected output (e.g. Foxit PDF Printer).

Check For Updates Online - Downloads new updates to T3RRA Design. Check the box to
get early access versions (see section: Updating your Software).

Auto-Update - When selected, T3RRA Design will automatically check for new updates.
Manage auto-saved backups - Reopens the list of auto-saves so you can open or delete
them.

Export all active layers to KML - Export visible data to a format that can be loaded by
Google Earth.

Exit - Closes T3RRA Design.

Edit Menu

Under the Edit menu you will find the following options:

Undo (Ctrl + Z) - undoes the last change made.
Redo (Ctrl +Y) - redoes the last undo.
Edit units - this allows you to change various units of measurement.

Note: you should restart T3RRA Design after making any changes to the units.

Edit credentials - user credentials are the same details used to access your users.t3rra.com
account. These details can be obtained by contacting your T3SRRA Representative.
Show Action Log - catalogues all steps taken to create the current design/project
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Surface Selections Menu
‘Surface Selections’ provides tools that can be used to select specific areas of the active
surface:

o ‘Select all’ - selects the entire field in the current layer.

e ‘Select all (including background)’ - creates a selection box from the widest points of the
current layer.

e ‘Select field edge’ - selects the outer edge of the field.

‘Select none’ - removes current selections.

‘Invert’ - inverts the current selection (e.g. if the edge is selected it will be inverted to

select the inside of the field.)

‘Expand’ - expands the selection by the set distance.

‘Contract’ - contracts the selection by the set distance.

‘Collapse selection to field’ - moves the selection to only apply to the active field.

‘Load/Save selection’ - save the current selection for later use/reference, or load a

previous selection to reuse.

Layers Menu

Under the Layers menu you will find the following options:

e Surfaces

e Boundaries

e Regions

e (uides
These options are also available at the top of the ‘Layer Selection Panel’ on the right of the
display.

Tools Menu

Under the Tools menu you will find 2 options:

o 3D Viewer’ (see 3D Viewer) - to look at a surface in 3D.

o ‘Simulate surface water flow’ (see Simulated Surface Flow) - which simulates a rainfall
event on the surface (this rainfall event is simulated as though the ground were a solid
surface such as concrete.)
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Help Menu

Under the Help menu you will find multiple options:

o ‘News and Social’ - Links provided to find us online

e ‘Change Log’ - Opens a .TXT file with a record of software changes for each version
‘Relink file associations’ - Sets windows defaults to open T3RRA Design when a
compatible file is opened directly from your PC.

‘Show .NET Status of this computer’ - Shows information about the computer currently
running T3RRA Design. This can be very helpful when troubleshooting.

‘About’ - Version Information

Toolbar

Navigation Tools

at{;.\ The magnifying glass allows you to zoom in or out on a selected point of a surface. Left
> clicking will zoom in, right clicking will zoom out. Clicking and dragging the left mouse
button will zoom in on an area of interest.

@ﬂg The grab tool allows you to move the surface on the screen by clicking and holding, then
** dragging. This is most useful with large surfaces or when zoomed into a single section of
the surface.

L& The pointer tool switches the cursor back to selection mode.

= 2 Zoom to full extent will change the zoom level to fit the entire surface on the screen.
B

£

The crosshairs will toggle on and off the display of a crosshair at the mouse’s position on
the working area.
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Ile}] The camera captures the surface as a geo-image with latitude and longitude or UTM
(easting and northing), in multiple standard image types.

@ Google Earth will capture the current display area and overlay it on a satellite image of the
field location.

Note: You must have Google Earth Pro installed on your computer for this to work.

/ The ruler is used to measure the distance along a selected origin point and the current
cursor position. Left-click to add points, and right-click to start measuring a new line. The
tool measures the total length of the line and the area enclosed by the line will also be
displayed.

'h Rotate will cause the surface to rotate 90° to the right with each click. There is no option
to change rotation direction or degrees it will rotate by.

Selection Tools
There are several selection tool options available. p | Goesseten.
. . : Point-to-Point Selection
To access more selection tools,l left click on the arrow nextt0 - rechang selection
the currently selected tool in the toolbar at the top of the 2§ Magic wand selection
screen.

......

Box Selection Box Selection allows you to select everything within a rectangular
space. To make a selection hold down the left mouse button and
drag until desired size then release the button to select and activate
the selection.

Circle Selection selects everything within the circumference of the

circle. To make a selection with this tool hold down the left mouse

button starting at your desired center point, drag the mouse away
to increase the size of the circle releasing the button once the
desired size has been reached.

Circle Selection
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Point-to-Point Selection allows you to make rigid
non-linear shapes. Click at each desired point and
double-click to finalize your selection.

Freehand Selection allows you to make free form shape
selection. Press and hold the left mouse button to trace
around an area.

......

Point-to-Point Selection

Freehand Selection

N . . ‘Magic Wand Selection’ allows you to left click on any
& Magic Wand Selection space to select all adjacent space that falls within the

selected height range.

Surface profile tool

a @ The Surface profile tool presents a cross-section of the field along the line
or path you specify. [t samples and plots the elevation of one or two
] _  surfaces at evenly spaced points along the line. The distance between
*  samples is specified in meters. It can also calculate slope.

B Profile = ]

Layer to profile: Elevation
Auto-select layer

Absolute Values | -Slups (%) |

1155

\alue (m)

115

rrrrrrrrrrrrrr
o 100 200 300
A --> B Distance (m)

[ Lock ¥ Axis

Sample distance [m]: [ 1000@

Angle [degk [ 12ee88F]
[] weight samples

[] Apply Savitzky-Golay Filter
Sample kernel (an odd whaole number):

® Details

1|

[ eporttocsv | | close |

When using the ‘Surface profile tool’, a window will open, displaying a plot of elevation along
the sample line. The sample line has three handles that can be dragged to manipulate the
line as desired.

T3RRA Design Manual Work In Progress - Page 25



T3RRA
aWNe

More points may be added to the sample line to create a non-linear path by left-clicking on a
red node. Red nodes appear when the mouse is in close proximity to a line. The red node
will turn white when clicked to show it can be moved to the desired location.

Visualization =
i = &

Visualization tools ™=

The ‘Visualization tools’ are used to view surfaces in different ways. The options available
are 3D Viewer, Simulated waterflow, and Wetting front.

When using the ‘3D viewer’, a window will
appear that displays the field as a 3D
model (shown below), this view can be
controlled with the mouse. All selected
surfaces will be displayed

e By left clicking and dragging on the E =
surface the model can be rotated, i
allowing for viewing from multiple T —— e
angles.

o The 3D focal point is indicated by the point where all 4 of the red lines meet. These lines
can be seen by holding the left mouse button down anywhere on the viewer surface.
Holding left-click and moving the mouse will also allow you to change the viewing angle.

o Holding the <Shift> key while left clicking and dragging allows you to shift the focal point
of the terrain model. This allows you to rotate around different parts of the model and
zooming in on the exact point of interest. Holding down the <Alt> key while left clicking will
cause the focal point to shift up or down only.

e Scrolling the mouse wheel will zoom in and out (based on the model’s current focal point).

-
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o Holding the <CTRL> key while scrolling will alter the vertical scale of the terrain model.
This controls exaggeration of the surface features and can be helpful to understand small
local height differences.

e (verlays can be added to the 3D Viewer by dragging the layer from the surface display on
the right of the screen onto the 3D Viewer surface.

How does this tool help?
There are multiple ways in which the 3D viewing tool can be implemented to make design work
gasier:

e Swapping between surfaces - Multiple surface layers can be added into the 3D
viewer. In the main window, activate (tick) just the base and final design surfaces in
your project, to show just two surfaces in 3D. Then by turning one off in the 3D
viewer and pressing the ‘Invert active layers’ button you are able to switch between
them to identify where the biggest changes were made.

o Fdge matching regions - Sometimes the design surface is divided into multiple
regions to allow custom designs on each part. For example, you may apply Multi-Fit
to two sides of a drain. This will often lead to vertical jumps or ‘cliffs” between
regions. The 3D Viewer tool allows for a more detailed view that is updated at the
same time as adjustments to the surface are made. This can help you line up the
edges of the design.

Adding Overlays to the 3D Viewer

You can drag any number of overlays and guides right onto the 3D Viewer window. This can
really help you understand the design. For example, you can add a cut/fill overlay, or a drain
line. If you drag in the wrong overlays, click the Clear Overlays button and start again. If
you just want to see the overlays, and not the surface elevation-based colouring, check the
“Only overlays” box.
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Simulated Surface Flow

The “Simulated Surface Flow’ tool s - - o X
opens a window to display a pRT R :
simulation of water flow across the =™ ~_
selected layer. The water simulator ¢ =L
helps understand how water will flow,
both on an existing field surface, and
on a surface with a design applied to
it. Bt
The layer selector allows you to
choose which layer the simulation e
will be applied to. BN
o The layers available in this st s
pulldown are the ones that
have been activated in the
main window surface tab.
The graph shows the percentage of water remaining on the field over time.
‘Depth to apply’ is a setting for the amount of water to be applied to the field.
o Alarger initial depth of application will cause the field to take longer to drain
o Differences in initial depth may cause different issues to become apparent - for
instance a large application may cause banks to overtop and different water flow
paths to become apparent.
‘Water on field’ displays how much water is currently on the field.
‘Water drained’ shows how much water has been drained from..
“Time (iteration count)’ is an indicator of how much time has elapsed since the model
started running.
Points to consider:
1. Time in the simulation is not any set measurement of seconds or minutes. The
passage of time is tracked with a counter called ‘iterations’.
2. The simulation should only be used as an estimate because the simulation does not
take soil qualities into account and treats the surface like a concrete slab.

-

% of applied water remain
=
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dee? Wetting Front

‘Wetting Front’ is a tool that allows you to visualize how a field will react with certain depths
of static water on the field.

The pop-up window for this tool
has 2 sliders that control the
water appearance on the field.

e The vertical slider controls
depth of water displayed on
the field, the sliders minimum
and maximum values are
based on the elevations of the
field.

e Right of the vertical slider is
the current ‘Elevation’, as
well as ‘Submerged area’

e The horizontal slider controls
‘Transparency’, the further to
the left that this slider is the
fainter the submerged area
will appear. If the slider is at its left most position the overlay will not be visible.

There are 2 checkboxes:

1. "Reversed’ will reverse how the overlay is generated on the field moving from the highest
point to the lowest.

2. ‘Output surface layer’ will create a surface overlay layer of the submersion data that is
being displayed when the tool is closed.
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mporting and Exporting Files in T3RRA
Jesign

mporting and Creating Surfaces in T3RRA Design

There are many different file types which can be used to import or create surfaces in T3RRA
Design. This will generally need to be done to start a new project.

The file type that you will be working with will depend on how you acquired your data. That is,
if you are a T3RRA Cutta user or a John Deere operator, you will have different types of
data available for import.

Note: Import elevation data into an existing nearby project to ensure the same UTM Zone.

Importing Elevations from T3RRA Cutta (.tci) to Create a Surface

|f you are a T3RRA Cutta user, you can easily import a surface from T3RRA Cutta into T3RRA
Design

1. Select the TCI button on the left hand side of the menu bar

File Edit Surface Selections Layers Tools Help

& iSurface Design bt = | o Tl I | iDrainage = == ¢ b ¢ Surface b .
&/D = +Tools: ; i I8 = +Tools: S Zap " =+ < ‘Derivatives: ™ - s A T ~

2. This will open up a pop up window, select relevant .tci file here and press OK

3. Once afile has been selected, press the open button and after a conversion process the
elevation surface and identified design surfaces will appear in the working area and the
layer selection area.

To import surveyed points from a .tci file and surface within T3RRA Design, from the top
Layers menu, choose Surfaces > Layer > Import > From raw data points (Deere RCD, CSV,
etc) > T3RRA Software Survey Points (*.tci) and follow the prompts.
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Importing Elevations if you are a John Deere operator

T3RRA Design can import elevation data from three separate John Deere sources. These are:

e John Deere RCD logs
These are from Gen3 and earlier John Deere displays (such as the 2630). You
would normally download the data from your display using a thumb drive and then
copy it to the computer running T3RRA Design. Be sure to copy the entire folder
structure, not simply individual files.

e John Deere RCD SWM Survey logs
Deere customers who have “Surface Water Pro’ may have data in this format. These
logs are collected specifically in the tractor as elevation surveys.

o John Deere Gen4 (ADAPT) logs
These are from Gen4 John Deere displays (such as the 4640). You would normally
download the data from your display using a thumb drive and then copy it to the
computer running T3RRA Design. Be sure to copy the entire folder structure, not
simply individual files.

Importing Elevations from John Deere RCD logs

Note: You must have a folder named RCD on your computer for this to work
1. Select the RCD button on the left hand side of the menu bar

File Edit Surfscs Selections  Layers Tools Help

b S Surface Design — L Ll | L i Drainage e b T8y Surface e =1 v
Ter . Tools: = 7 b I~ « ‘Tools: e 3l ‘ = =% - ‘Dervatives; N7~ - i T -

2. This will pop up a window, select relevant RCD file and press OK

The soldier who survived mustard gas and pepper spray is now a seasoned veteran.

3. Once afile has been selected, press the open button and after a conversion process the
elevation surface and identified design surfaces will appear in the working area and the
layer selection area.
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Importing a Surface from an Existing Elevation Surface
By working in the Surface Tab in the Layers Panel, select: Layer > Import > From existing elevation

surface:
PCT Image elevations (*.pcti) - '{’2}' ;'G —
. | hegons te) Liges,
USGS DEM elevations (*.dem) ‘ Surfaces (7) | Baundaries (1
|[ Layer | Select Visibility |
Open overlay images b
Edit ‘D

Space Shuttle Radar Topography
Create boundary from selected layer iy

Generic XY/ elevations (*.xyz)

DXF (*.dxf)

LandXML surface (*.xml)

JSONGrid elevations (*jsongrid)

Surfer grid elevations (*.grd)

Esri ASCII elevations (*.asc)

UK LIDAR (OSGB 1936 / British National
Grid (*.asc)

Trimble Field Level Il (*.gps)

e Fzigrade surfaces (*.ezigrade)

Create region from selected layer

Activate all i
Activate selected
Deactivate all
Deactivate selected

y
Delete selected

ity: -

£
D

Delete inactive

Import 3
W Multi
Export 3

View in Google Earth
Make selected surfaces design !

Make selected surfaces overay

Make selected surfaces base surfaces
T

Examples of Importing a Surface from an Existing Elevation Surface

File Type: DXF Surface

DXF files are a standard format used by civil designers, with file names that end in “.dxf”. They
can contain all manner of drawings and text in 2D and 3D. Because of this, they are not
georeferenced and require you to know the georeference information. They can be exported
from all civil CAD programs. We support importing surfaces from DXF, but also linework
and markers.

Note: DWG is a file format related to DXF. If you encounter a DWG, we recommend you request
your designer to re-export it as a DXF. It is possible to convert most DWG to DXF with free
tools like “DWG DXF Converter” by AnyDWG Software (available in the Windows Store).
However, the quality of the conversion is not guaranteed.
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To Import a DXF Surface:

From the Surface Tab in the Layers Panel, select: Layer > Import > From existing
elevation surface > DXF (*.dxf)
Select the relevant option from the below list:
o DXF 3D Faces (*.dxf)
o NOTE: If you are not sure, choose this, as it is the most common option.
o Itis when you have triangulated points to create an elevation surface.
e (ridded DXF elevation points (*.dxf)
o Isagrid of regularly spaced points with no triangles between them.
o DXF PolyFaceMesh (*.dxf)
o This is an uncommon alternative mesh format, usually with a mesh composed of
squares.

This coordinate system selection window will then appear. Since projection information is not
included in DXF files, you will need to select it now. This tells the importer how to correctly
interpret the X, Y and Z coordinates as locations on the Earth.

Common selections include: cooreinete Syster -
o WGSB4 (longitudes and latitudes) is under: ® Named System O Local System O Proj4
@ Named System Type:
> Type: Geographic e :
> Category: World R .
> Projection: WGS 1984. Projection:
e UTM Zone projections are (see screen capture for | | WGs 1984 UTM Zone 565 v
an example]: Planar units: Elevation units:
@ Named System MeteE o == :
> Type: Projected K| | Cancel
> Category: UTM Wgs 1984,

o Map Grid of Australia projections are under:
@ Named System
> Type: Projected
> Category: National Grids Australia.
o State Planes are under:
@ Named System
> Type: Projected
> Categories like State Plane Nad 1983 Feet.
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NOTE: Be sure to select the correct planar and elevation units from the dropdown menus for your
data too.

A local system is a custom coordinate system, and you will need the reference longitude and
|atitude, the location of the reference point locally, and the local system type (e.g. Orthographic).

After selecting ‘OK’, the ‘Import elevation surface’ screen will pop up. Ensure you select the
appropriate pixel size (in the lower right of the window) for the type of work you are doing, but
remember that smaller pixel sizes produce larger files that take longer to process. If there are
multiple layers in the file, you can select them with the drop-down in the lower left of the window.
| BB import elevation surfac 5

T‘ariﬁ available Q\ (5'7‘9 Lg Zi 4 Ejj@// +\ .
Q

File |

&

Import layer: | 0 v UTM zone: | 14 ~ Hemisphere: N * | Surface resolution: | 2 (Good for most purposes)
Wikipedia UTM Map

| Distance East/West: 1128.00m Distance North/South: 1300.00m  Area: 7649ha Values range: 295.75 - 306.95

| Impaort current elevation surface ‘ | Close |

At this point, it is recommended that you verify the projection was correct by opening it in Google
Earth.

NOTE: You must have Google Earth Pro installed on your computer to do this.
To export it to Google Earth: @
> Select the Google Earth icon

> Enter a name and click OK

in the toolbar
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> Compare the elevation map’s location to the satellite imagery. If the
projection is correct, it should line up pretty well with field boundaries and
landmarks.
In the ‘Import elevation surface’ window there are several options:
e |mport boundary - This allows you to import only a part of the field. You can draw a
boundary polygon in Google Earth, export it as KML, then import it here. Note that a path
(like a polyline) is not a valid boundary - it has to be a polygon.
e |mport layer - Select which layers to import. Some files contain more than one surface
layer.
e UTM zone and Hemisphere - For new projects, when your field crosses a UTM boundary or
hemisphere, you can choose which UTM Zone it is imported into.
o Surface resolution - Read the descriptions for each pixel size to help you choose
appropriately.
NOTE: The lower the surface resolution, the longer the import will take to complete.

File Type: Trimble Field Level I (*.gps)
2ps files are used in Trimble FMX and TMX displays

To Import a.GPS Surface:

> From the Surface Tab in the Layers Panel, select: Layer > Import > From existing elevation
surface > Trimble Field Level Il (*.gps) > Select the relevant file

A box will appear stating which
SUI’fE]GB rBSO|UtI0n haS been SB|BCth baSed We have selected the closest surface resclution available (5->8m)
on the file you are importing.

[ ok

At this point, it is recommended that you
verify the projection was correct by opening it in Google Earth.

NOTE: You must have Google Earth Pro installed on your computer to do this.
To export it to Google Earth: @
> Select the Google Earth icon

> Enter a name and click 0K

> Compare the elevation map’s location to the satellite imagery. If the
projection is correct, it should line up pretty well with field boundaries and
landmarks.

in the toolbar
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In the ‘Import elevation surface’ window there are several options:

Import boundary - This allows you to import only a part of the field. You can draw a
boundary polygon in Google Earth, export it as KML, then import it here.

Import layer - Select which layers to import. Some files contain more than one surface
|ayer.

UTM zone and Hemisphere - For new projects, when your field crosses a UTM boundary or
hemisphere, you can choose which UTM Zone it is imported into.

Surface resolution - This will be preselected (see above) during the import process.

NOTE: The lower the surface resolution, the longer the import will take to complete. .

Once you are happy with the above

surface and selections, press ‘Import _
current elevation surface’. A pop up 0 st et ravsre R b e ot
window will appear:

This then imports that surface into

The elevation surface was successfully imported. You can go ahead

the working area of T3RRA Design,

while still keeping the ‘importer’ running. You can either close out of the Importer or import more
surfaces if required. It will also import the linework and master benchmark (MB) into Guides.
These can be included in a .gps export to ensure it has the same reference point.

Importing a Surface from Raw Data Points

By working in the Surface Tab in the Layers Panel, select: Layer > Import > From raw data points
(Deere RCD, GSV, etc.):

John Deere Gen4 ADAPT (logs)

John Deere RCD logs

John Deere RCD SWM survey logs

Raw CSV Data Points (*.csv) - can thin points to be more manageable
Raw shapefile data points (*.shp)

Multiplane data points (*.txt)

FieldLevel XML survey points (*.xml)

APRS LASer file format (*.las/z) - can thin points to be more manageable

Examples of Importing a Surface from Raw Data Points
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File Type: Multiplane data points (*.txt)

To Import:

> From the Surface Tab in the Layers Panel, select: Layer > Import > From raw data points
(John Deere RCD, CSV, etc) > Select relevant Multiplane (*.txt) file.

Once you have selected the relevant file to import, the following pop ups will appear:

II Select 'YES' if the Multiplane file

' Is this Multiplane file in meters? (Press ‘No’ if the data is in feet) iS iﬂ meters or ‘NO’ |f |t iS in feet.

l Yes H No }

e &

This file has a height offset of 317.162m. Is this the actual height at the benchmark
rather than an offset? (Press ‘No' if unsure)

The next pop-up will be:

Sometimes the master
benchmark has a separate
offset, but it is actually the
elevation there.

This is a somewhat unusual variation, so you're advised to press ‘No’ if you're not sure. If you will
be exporting your design to a Multiplane file, a .gps file or a FieldLevel.xml file, the height
mentioned here can be used for your Master Benchmark (MB) in those exports. In that case, import
the MB from the same Multiplane file by going to the Guides Tab in the Layers Panel and selecting:
Layer > Import > Import benchmarks from Multiplane file. The same pop ups will appear.

Yes || No
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Continuing on, a new import screen will appear. Here there will be many of the same tools which
can be found on the standard T3RRA Design screen. These tools include:

o Navigation Tools

o The Pointer Tool
The grab tool
The magnifying glass
The ruler
Zoom to full extent
Rotate
The crosshairs
The camera
o (Google Earth

To find out more about the above tools go to Navigation Tools

e Selection Tools are always available in a drop-down list. To find out more about these tools,
g0 to Selection Tools

O 0O O 0O O O O

i Area surfacing Linear path surfacing

k r\‘-':f C':'z\ & Ba *"\ & @ fpaomas iE 48 [ 100 20 2 (Good for most purposes) ~
[ SN i . : |G| Search radius{m] 4= | Pathwidth (m)  Separation (m)
: = m) Ay Surface resolution

Points Values range: 293.49 - 317.35m

Import buttons are enabled once a surface is present | Close
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Area surfacing

i Area surfacing

& SEarcm:fnus(m} The search radius (m) is pre populated based on the data set that has been
i imported. This figure can be changed to to achieve a different surface
outcome.
Gz

> To surface all points, click this icon

NOTE: Depending on the size of the surface, this can sometimes take some time to process.
NOTE: If your surface is not complete (i.e. there are areas of white), you will e
need to remove surface” by clicking the icon on the right and increasing the = i
.
search radius.

Linear path surfacing
- 10.0 20
e N -
v, | Pathwidth (m)  Separation (m)

Linear Surfacing

Linear path surfacing is for when you have a single string of survey points. Since it is a single
line, this method does not triangulate between nearby points - it sets the elevation of each
pixel to the closest survey point. Linear path surfacing is the same as surfacing drains in
T3RRA Cutta.

Surface RBSU'UUUH 2 (Good for most purposes) ¥
This setting allows you to select the pixel size for the (0 M e

0.25 {Qverkill for most things)

surface that you are creating. Smaller pixels are g00d o5 erecice terrain in small areas)
for precision drainage work, larger pixels are good for 1 (Drom swde slope word

. . [2 (Good for most purposes)
Wlde Scale |eve|mg 4 {For broad-acre drains work]

& (For large scale contour bank/terrace designs)

16 (Large area topographical analysis work)
32 (Mery large area topographical analysis work)
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Once you've surfaced and are happy with the results, click the “Import current elevation surface”
(1) button at the bottom of the window (see below). Click OK on the prompt that comes up (2), and
then click “Close” (3) to get back to T3RRA Design and work with your new surface.

------- g Lnesr peth serfscng

voasithtwe 5 | W T

Elvation poinll cpacity  Surfals opanty

The elevation surface was suctessfully imported, You can go ahead
and import more fields if you have more data...

OK |

Fownia Vabers e ST AT |_.'-|-- . .I 3 “+

% b
I VPRt Dal PerT) SPaaeon pailand ] Ciiie I
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Exporting Files from T3RRA Design

You can either export individual layers from T3RRA Design (and depending on the type of layer
that you are trying to export, there will be a variety of formats available) or you can export
a control file with either individual layers or a combination of layers.

Exporting Files - Individual Layers

To export a file from T3RRA Design, there are two ways to do this:
1. Click ‘Layers’ in the top menu bar
> Select which ‘layer type’ you are wanting to export e.g. Surfaces
> Layer
> Export

2. Inthe Layer Type Selection window on the right hand side
> Select the relevant tab and ensure the individual layer is highlighted
> Select ‘Layer’
> Export

As stated above, depending on the type of layer you are exporting, there will be a different
selection of file types available. These include:

e Surfaces
o kml
.CSV
.csv (CSV UTM)
.csv (CSV Grid)
zsv
el
(xf (This is a great format for most CAD packages like AutoCAD, QGIS, Magnet and
BricsCAD)
o jsongrid
o .shp
o .red (Deere Background image)
e Boundaries
o .Shp

O O O O O O
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o kml

o .0SV
e Regions

o .Shp

o kml

o .0SV
e (uides

o .Shp
kml
.CSV

O O O O

Exporting Files - Control File

(xf (this is limited to poly measurement lines)
Guidance lines (this is limited to poly measurement lines)

T3RRA
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It is also possible to export a Control File from T3RRA Design. This is how you get your design
into a tractor or bulldozer with T3RRA Cutta (.tci), or produce a Trimble FMX/TMX
compatible file (.gps). You can either create a control file with an individual layer or by
combining many layers, such as surfaces, guides, regions and boundaries, etc.

To export a control file, simply select the below icon on the menu bar at the top:

File Edit Surface Selections Layers Tools Help

QO N[ L

Once selected, a box will pop up. You will then be
able to select from a drop down menu, which file
type you are wanting to export. The options are:

e T3RRA Cutta (*.tci)

Field Level Il for FMX/TMX (*.gps)
SBG SmartProfiler Shapes (*.shp)
Comma Separated Values (*.csv)
Ezigrade (*.ezigrade)

DXF 3D Faces (*.dxf)

Field Level XML (*.xml)

LB

=

A 8 Visualization
f— ET@I ﬁ@b _ Tools:

S

7y oo
SH . -

Control File Export

) Export type: | T3RRA Cutta (*.tci)

Layers to exp{ T3RRA Cutta (*.tci)

Drag { Ezigrade (*.ezigrade)

and DXF 3D faces (*.dxf)
i ‘Surfal Field level XML (*.xml)

Field Level Il for FMX/TMX (*.gps)
SBG SmartProfiler Shapes (*.shp)
Comma separated values (*.csv)

arains, TNEWork and Tabers.

Remove selected |

Remove all
Cancel
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After the export file type has been selected, you need to drag layers from the ‘Layer Type Selection
Panel.

From the Surface Tab, these will (could) include:

e Design surface
e Base surface (optional)
o Difference surface (optional)

You can also drag in several other layers, like from the Guides Tab, including Drains, Linework, and
Labels (e.g. a Master Bench). To remove layers, select them and click ‘Remove Selected’. You can
also remove all layers as well.

NOTE: The ‘Export” button will remain inactive until you
have included the minimum layers needed for that
export file type

N Export type: | DXF 3D faces (*.dxf) v
Layers to export:

Exporting a DXF Control File ’g"\\ S

The DXF file type is a common interchange format
used by civil designers. We support exportinga ~ §
DXF file of a surface. [t may be exported as 3D &
faces or a grid of points. A 3D faces file contains
a collection of triangles that define the surface.

To export this type of file:
> Open the Control File Export window as [ Removeselected | |
described above. [ epot | [ cancel |

> Select DXF 3D faces (*.dxf) from the Export type

i BA3E rt to DXF X
drop down list. 7] Export to
> Drag and drop required design surface layer. Geometry
> Select Export. Export: O Grid Points
®) 3D Faces

> Then a few more options will appear. Choose
your export type, file size, and coordinate

File size: 100 %

system. A lower file size is achieved by Frron 0000w/ ba

intelligently simplifying the triangles that are Export coordinates as

output. ® WGS84 O UTM 555 O Named System
> Ensure you record which coordinate system and

give this information to whoever will be using [ ok ‘ ‘"Came,'

the DXF file. | |

> When you have specified each option, click OK.
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Exporting a Field Level Il for FMX/TMX (*gps) display

The .gps file is used in Trimble
displays. We support exporting Control File Export
files for these systems with a
design surface, a base surface,
linework, and markers. To export
this type of file:

> (Open the Control File Export
window as described above.

Export type: | Field Level Il for FMX/TMX (*.gps) hd
Layers to export:

Drag MB marker, design surface, base
surface (optional) and difference surface

> Se|eCt F|e|d |_BV8| || f(]r FMX/TMX (optional) from 'Surfac.es' ta.l:l into this area.
[*.gpS) frﬂm the EXDOFt type dmp We also accep;:l:z::z, linework and
down list '

> Drop and drag the required layers,
ensuring you include those that

are required (MB Marker deSign Warning: Design surface is mandatory!
Surfa(}e) | Removeselected | | Removeall |

> When you have finished selecting -
layers, click OK. ‘ Export
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Regions Guides (5)

Su rfa C e -|-0 0 | S Surfaces (2) | Boundaries (1)
Select Visibility

When the Surface tab is selected on the right hand side, the relevant tools = E“"a“‘”””w
can be accessed in two different areas. Firstly, on the menu bar (this

changes depending on which layer type is selected) and is explained ) |
below in Surface design tools and secondly, in the Layer menu on the - D
selected tab and is explained in Surface tools - Layer Menu. i

Surface design tools y

:Surface design A , = 1\ 28 = 5
Tools: EG‘DE&"’*’VVA":

The ‘Surface Design Tools’ are used to create designs for the whole surface. Before any
designs are able to be made, the surface you want to work on must have a boundary and
any desired regions.

A Create a surface design for the selected area

v This tool is the primary method for creating field designs. This tool opens a window
with several design options to choose from: ‘Plane of Best Fit’, ‘Directional Best Fit

Design’, ‘Multifit Design’, ‘Omni-fit Design’, "Surface Smoothing Design’, and Duplicating
the current surface.

All the options available in the create a surface design tool can be limited to the boundary, all
region parts, or an individual region.

The additional options that are available in most surface design options are “Shift design
vertically’, ‘Cut/fill ratio’, and ‘Import/Export’.

o ‘Shift design vertically’ will move the design layer vertically according to the value that is
input. A negative value should be used to move the design down.

e ‘Compaction ratio’ will adjust the design to accomodate a specific cut /fill ratio.

o ‘Import/Export’ will set the design to ensure a certain amount of soil is present to import
and available for exporting. (importing and exporting volumes cannot be set at the same
time)
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Plane of Best Fit
A"Plane of Best Fit' will attempt to create a - [—————— =
flat plane on the elevation surface that flows ) s *
: o o Plane Of Best Fit Design ‘
with the field’s natural slope direction.
— — ++
‘ o A || A ‘ A A AY ‘ N/ ‘
e The 'Plane of Best Fit" will apply both : 2
a primary slope and a secondary ARG : —
SlOpe. The Secondary SlUDe WI” | Boundary All region parts | | Individual region part |
always be at 90° to the primary. The Primary Slope Direction [123.2887] 0.067%
Secondary Slope Direction [213.2887] 0.000%

direction of the slope is shown next
to the S|0pe and ’[he Severi’[y of ’[he @ shift design vertically | 0.000 & m O CutsFill ratio

slope is displayed on the right side of | — ™"
the window. () Design details
I@ Close Cancel

e There are 3 design options for
creating a ‘Plane of Best Fit’.
o ‘Shift design vertically’ changes how far above or below the design is made from
the surface.
o ‘Cut/Fill Ratio’ allows you to set the ratio of the Cut and Fill to what is appropriate
for your soil properties.
o ‘Import/Export’ allows you to set how much soil needs to be brought in from
another location or how much needs to be taken from this location to be used
elsewhere.

o The Design details drop down will display information about the design such as the total
area, total area cut, total area filled and volumes.

o Show cut/fill surface, this button is a toggle which will only show the Cut/Fill while it is
selected.
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Directional Best Fit Design

‘Directional Best Fit’ creates a straight plane
and allows you to completely control the
direction of the field slope.

e When using ‘Directional Best Fit' a
blue line will appear on the field. This
line is used to control the direction of
the plane.

o ‘Auto-calculate best fit’ will have the
tool automatically generate the most
effective plane of best fit in the set
directions.

e ‘min(x)% to max(X)%’ will tell the
tool to generate the most effective
plane of best fit following the set
direction and within the set
parameters.

T3RRA
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Surface design controls n
Directional Best Fit Design
— — + |
5 || A9 | A || A N
Apply design to
| Boundary | | All region parts l | Individual region partl
Primary Slope Direction [276.539°] Secondary Slope Direction [6.539°]
® Auto-calculate best fit ® Auto-calculate best fit
[Imin 0.000 % to max 0.000 % [CImin 0.000 9 to max 0.000 %
() Set % slope 0.060 % [V Cannot exceed primary slope
) Set % slope 0.030 %
Primary (X) Direction [degrees]: 276.5388 E[
| Divide area into parallel strips
®) Shift design vertically D.DUD% m O Cut/Fill ratio
O Import/Export
Close Cancel |

‘Set % slope’ will create a plane of best fit at the set slope value in the set direction.
‘Primary (X) Direction’ displays the current direction of the line and allows you to manually

set the slope direction without using the blue line.

The field design is also able to be split into parallel strips. These strips will flow in the direction set

by the primary slope.

o There are also options such as shifting the design vertically by a set distance, set a Cut/Fill
ratio and setting the Import/Export for soil that may be brought in from another location.
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Mu'tl—l:lt Deslgn .Surface de5|-gn controls nl

. . . . . Multi-Fit Desigr
Using Multi-Fit design will create a design for S
the field in the work area that follows thg A | A || A AS | AL || A/
movements of the surface more closelyinan | =
attempt tU reduce the amount Of earth mUVGd. | Eoundary ] | All region parts | Individual region part |

Direction (degrees): 93919 E

The desired direction can be set using the Plan stip width ()
‘Direction (degrees)’ option which will shift the | sectoniengi i
dlrectlon Uf the ||ne Set slope range from  0.050 {min %) to 0.200 {max %)

] calculate only cuts (to create flossing related layer)

o A Multi-Fit design is made by breaking | rerform aosstp eptmizaton ey ot needed on feldswith o sd-dcpe
. . . Target Cut/Fill Ratio; 1.00
the surface into strips and cutting

[ Perform preliminary side slope adjustment

those strips into smaller sections. ] xecute multiple; sequentia, directional it
o ‘Plane strip width' controls NOW | © s seian ersety ssoofln  © cuvmne
wide the strips are that the Qleperia
field is broken into. P |
o ‘Section length’ controls how [ [Srovewatarec) | ctose | [ conce
long each segment is along
each strip

o The smaller the value set in these options to the smoother the design will be, but
the longer it will take to calculate.

‘Set the slope range’ creates a minimum and maximum grade that you want to be present

in the design. Multi-Fit will attempt to follow the natural flow of the field within the set

range.

e ‘(Calculate only cuts’ this option will tell the tool to ignore any section that requires a fill.
The resulting surface will be at or below the original surface at all points. This parameter is
normally activated in situations where you always want water to flow in the primary
direction and do not care what the maximum slope is. It will create a design where
obstructions to flow are shaved away and naturally draining sections remain undisturbed.
The most usual use case for this option is when flossing” existing beds in furrow irrigation
scenarios (the cut dirt is swept up onto the beds, so fill zones are not required).

o ‘Perform cross-strip optimization’ this option will tell the tool to optimize the design by

checking it against a secondary slope. This may not be needed with fields that have a low

side slope. This will attempt to tilt the strip sections to match the actual side slope present.

Use this parameter in fields that have high side slopes. It is unlikely to provide any benefit

in relatively flat fields.

Target Cut/Fill" allows you to set the desired cut and fill ratio for the field.
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o Perform preliminary side slope adjustment’ this option will cause an initial side slope
adjustment to occur. It will attempt to ensure that the side slope is no greater than the
minimum row slope. Use this parameter if water might have a tendency to run across rows
rather than down the rows. It always uses the ‘minimum parameter’ as it's ‘maximum

parameter’.

e ‘Execute multiple, sequential, directional fits’ is an option to “customize” the land forming
design by breaking it down into multiple slope directions. This is for an advanced user with

engineering knowledge.

Multi-Fit tends to keep closer to the starting elevation of each strip than the end elevation. If you
want the Multi-Fit to keep the end elevation close to the existing level, reverse the direction (add
or subtract 180°), and swap your minimum and maximum grades. Additional options include being
able to Shift design vertically by a set distance, Cut/Fill allows you to set the cut and fill ratio, and
Import/Export which allows you to set the amount of soil that may be brought into or out of the

field.

Note: Vertical offset relates to the ground, not the orientation of the computer monitor.

Omni-Fit Design

‘Omni-Fit"is best suited for smaller
fields.

‘Omni-Fit’ is the implementation of a
Multi-Fit surface with an added
secondary slope allowing for further
controlled water flow direction.

e ‘Primary direction’ is used to
adjust the main direction you
wish the slope to move in.

e ‘Secondary direction’ will always
be at a 90° angle to the ‘Primary
direction’.

o ‘Target Cut/Fill Ratio’ will adjust
the design in order to match the
cut and fill ratio that you put in
this section.

e ‘Import/Export’ sets the amount
of soil that would be brought into

Omni-Fit Design

—

A || A2 || A

AN

Apply design to

I

| Boundary
Cautionl Omni-Fit is

Primary direction (degrees):
Secondary direction (degrees):
Target Cut/Fill Ratio:
Import/Export (m?)

Limit slope change to at most

Primary Direction Slope

Minimum (35} Wl 0.000

Maximum (%) W/110.200

I @ Advanced Options

® shift design vertically | 0.000 M m
) Import/Export

@ Design details

‘ Show cut/fill surface ‘

All region parts

Individual region part |

in Beta Preview. Use only on small fields or with large pixel sizes

Enzure there are no small holes in the fiald.

0.00=]
90.000
1.000
0.000
| 0500  Boper 1.0 m

Secondary Direction Slope

Minimum (%) [+ 0.000

Maximum (%) [v]|0.200

Cut/Fill ratio

‘ Close ‘ Cancel
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and out of the field, this is measured in cubic metres.

e ‘Limit slope change to at most (%/m)’ is an optional setting, by putting a value in this
setting you are able to limit how sharply the field's slope may change.

o Pressing the Question mark button next to this tool will open a graphic calculator
making it easier to find the % per unit of measurement.

e Primary and Secondary direction slope allows you to set the minimum and maximum grade
of slope that can be present in the design. Setting the slope for the secondary direction is
an optional setting.

The Following settings are available by clicking on Advanced Options

o The ‘Engine’ setting. These are external optimization software engines. COIN-OR Clp will
complete the work faster, whereas LP Solve is more robust. If you are having issues with
COIN-OR Clp try switching to LP Solve.

o The ‘Quality’ option controls the field resolution used by the optimizer. “Draft” is
recommended for normal use as it takes far less time to process. “Final” takes significantly
longer to process the field data but creates a finer surface, best used to optimize finer
details. When you have settings you are happy with in Draft mode, save your work (as a
separate file), then you can try running it overnight with Quality set to Final. Be sure to
stop your computer from going to sleep while running the optimization. Be warned, it can
take a lot longer to complete a final run.

e The Advanced Options allow for specific limitations to the elevation as well as maximum
cut and maximum fill. The maximum cut and fill can be set to a maximum distance to cut or
fill by, as well as a maximum total amount of soil cut or filled from the area. Be careful with
these, as if restricted too much there will be no valid solution.

e The Cut/fill option at the bottom of the window is disabled in the Omni-Fit tool to ensure it
does not interfere with the Target Cut/Fill’ setting.

Surface Smoothing Design Al AT A RS W- o |

The surface smoothing will smooth out any dips or bumpsin =~ S s s |
the surface by taking samples from the surrounding points ... A —
and generating an average of what the surface should be. ]
The smoothing tool changes depending on whether you have
‘Directional smooth’ checked or not.
Without Directional smooth

e The ‘smoothing strength’ slider controls the Size of the 1, ... o cmmme

radius T3RRA Design will look at for each point in | ‘e
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order to smooth the surface. The larger the radius, the smoother the surface.
With Directional smooth

e This will smooth more in one direction than the other. It is useful to quickly increase
trafficability in the row direction, and will move less dirt than the equivalent
‘non-directional’ smooth. The second slider that appears controls the smoothing strength in
the secondary direction (right-angles to the primary direction). It should normally be less
than the first smoothing strength.

Duplicate Current Surface
Duplicating a surface will create an exact
copy of the currently selected surface.

The area that is copied can be limited to the
boundary of the surface in the working area, ~ AeP¥eeon i o]
a” the regIOHS, ora SII’Ig|e SpBCIfIC reglon | Boundary | All region parts Individual region part

[® shift design vertically O.DDUE m Cut/Fill ratio

(O Import/Export
Close Cancel

Duplicate current surface

e

A g AT
Y || TV

A

N

Adjust surface (used to adjust a design =
Surface) Surface Adjustment

Apply adjustment to

‘Surface Adjustment’” allows you to make additional | [-ewder | [tisgonpars | [ndvuairegoncon
changes to the designs that were made in the layer | sesverecise sl

Rotation axis [degl | 1517 [

creation. T e
o ‘Vertical offset’ which can be adjusted with up and | oeonsursce [adusiod s
down buttons at 0.01 increments or by typingina | *
set value to shift the design vertically up or down. |z e =
e ‘Rotation axis’ This can be adjusted by typingina ¢ & 5
value, using the up and down buttons or by using ~ § ==
the yellow dot that appears in the working area.
o ‘(ffset at tip point’ works in conjunction with the
‘Rotation axis’ setting to make the changes along | =™
the set point.
e The bottom portion of the window displays
information about the whole design surface and the

49,47 m
igher than original = 21.22
1 itr. higher than original =

|Show cutf'lillsurface| | Apply adjustment | Reset adjustment |
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adjusted part, including a comparison to the original elevation surface.
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As you make changes, the cut/fill map will automatically adjust accordingly. Once you are done
changing it, you need to accept or reject it by pressing either the ‘Apply adjustment’ or the ‘Reset

adjustment’ button at the bottom.

Structured Surface Warping™ n
°— Structured Surface Warping o Sructured Surfsce Warping™
‘Structured Surface Warping™ allows controlled T — o
manipulation of the field. This tool can be used to I
create non-standard designs. R
e The warping area is designated by the blue square and siom  [on@n  wm
can be manipulated by using the yellow anchor points. i tan @
o The blue numbers under each point in the pop-up 030B] m [ 03B m [ 030 m
window are the distance of each anchor from the el S
central point. o0 o0Bn  0w0m
o ‘Rotation (A->B) Displays the current heading of the e
line between the A point and the B point. The rotation * oson surtece [agusted rar
can also be manually set in this option.
e The values corresponding to each anchor point will
adjust the vertical shift of the surface around the area
of said point.
[ Rt |
7/
o :
£z (Gombine Surfaces D
Combine surfaces allows you to combine multiple elevation and B -
design surfaces into a single layer. This tool can be used to I _
combine multiple surveyed fields into a singular layer for a - .
full farm view. ;
Drag the layers you wish to combine into the pop-up window. - '
Select what type you want the output layer to be before
closing the tool. e [ |
Note: If there are any overlapping areas in the selected layers, it e ||

will pick the topmost in the list for the result.
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== Expand/contract surface
The ‘Expand/contract surface’ tool allows you to make a surface larger or smaller.

To expand the surface:

Enter a positive value into the “Expand or contract” field. When making a surface larger, it
takes the available information and makes an estimate to try to create the area outside the
existing elevations. You can choose between these expansion methods:

o Flat: Simply uses the closest elevation point and extends based on that data

e Trend 1: Each new pixel is calculated from just the original elevation surface pixels. Pixels
close to the edge use near elevations. Pixels further from the edge use existing elevations
in a wider range.

e Trend 2: Expands the field iteratively, in pixel layers out from the existing edge. An
additional parameter is available for
this method. It allows you to modify '
how far the pixel by pixel expansion of *
Trend 2 will look for elevations. A .
larger number will lead to a smoother

Layer to expand/contract: Base layar

expanded surface Expand (+) or contract (-} by: | 1000[&] m
NOTE EXpaﬂdlng a Surface IS by nature an Expansion method: () Flat @ Trend1 () Trend2:| 20
estimate or guess. It will not be accurate. L

®) Qutput new surface () Modify existing surface

| Apply | | Close | |Cancel|

To shrink the surface, enter a negative
value into the “Expand or contract”
field. When shrinking, elevation points will be deleted.

The option is also available to either create a new surface or to modify the existing surface. Select
the appropriate button for this.

To calculate and apply the expanded or contracted surface, click the Apply button. Once it has
been calculated, you may modify its transparency with the slider. To keep your new/changed
surface, click the Close button.
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way up to 1024 meters. gResamp!e All Layers . ) T X
The smaller the pixel size the more detail

there W||| be on the Surface in the Pixel sizes are always in meters. 1 meter = 3.3 feet (approx.)

working area and vice versa, however New pixel size: | 2 (Good for most purposes) ¥

B
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s Change pixel size for all surfaces

The function of this tool is to change the size of the pixels across all surfaces. The
pixel sizes are read in meters, for example if the pixel size is set to 2 then each square dot
on the screen is equal to 2 square meters in the real world. The sizes available in T3RRA

Design go from 0.5 meters all the

the smaller the pixel size the more
strain T3RRA Design will put on your

‘ Apply H Cancel |

computer, so use at your own
discretion.

e

A~ Smooth Region Boundary

"Smooth Region Boundaries’ is used to smooth the

transition between different regions in a design.

The top slider is the ‘Max Allowable slope’. It sets
the steepest allowable slope in the transition
around the region lines.

The bottom slider is ‘Distance From Region line’.
This sets how far away from the region line
blending can occur.

Both values can be set manually by typing a value
into the spaces available underneath the sliders.

IZ% Smooth Region Boundaries X

Will smooth x distance away from all region borders.
Max allowable slope

3.00|%
Distance From Region line

10.00| m

l Apply H Cancel |
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— Create a cut/fill overlay

‘Create a cut/fill surfaces’ creates
a surface layer that shows how much
soil must be moved to and from areas

to reach the design surface.

To create a cut/fill map start by
selecting a design surface and
dragging it into the left side box, and
drag an original elevation surface into
the right box.

‘Surface statistics’ displays the earth
moving details between the 2 layers.
The slider allows you to adjust the
point of the largest fill and deepest cut
and set whether the Cut/Fill surface
should display heights equal to and

T3RRA
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- - -~

Designed surface(sh:

0 Elevation Design Surface

Source/base surface(s):

‘/, Elewvation

|

] Restrict to designed surfaces | Restrict to source/bass sun‘a_ces

cted | Remove all | selected | Remove all
Surface statistics
m* /ha}
B m*/ha
X ce i a
Cut Fill
ok o157 I [
&[] Alter design surface height Close Corice!

within this range, equal to the slider points and outside the range or just everything equal

to the range found.

i2x Show design surface

balance figures

This tool provides a separate output of the
information that is available in other
tools, this tool is limited to only design
surfaces. This information displayed
can be limited to the boundary, a single
region or a group of regions.

Calculate design surface information based on:

® boundary (O all region parts () individual region part
Earth wor

: 60.3 ha

T L cut area: 31.6 ha
Total fill area: 28.7 ha
Max cut: 0.07 m
Max fill: 0.19 m
Total cut volume: E&009 m® (99.6 m?/ha)
Total fill volume: 5035 m? (63.4 m®*/ha)
Actual cut/fill ratio: 1.19%

ks details

Elevation face mean = 115.21 m

New surface mean = 115.21 m

New surface % area higher than original = 47.64

New surface % vol. diff. higher than original = 45.59

Copy to clipboard
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Drainage Tools
—=
Fill Depressions
‘Fill Depressions’ creates a design
surface with the largest Transparency:
indentations in the field filled in.
A pop-up window will appear allowing Diipiitsusidee lage Close

you to change how transparent the
fills are on the field as well as a
checkbox that will allow you to select whether you would like a surface layer to be created

from this tool or not.
T3D

= Breach depression
@ . Layer to breach: | Elevation b
Breach Depressions

‘ . ) Transparency:

Breach Depressions’ allows you to
break ’[hrough ) depression and ® Output new surface (O Modify existing surface
allow water to flow out. [ ] Create breach paths as polylines on close

e ‘Layer to breach’ selects which Min path length 10,00 5 m
surface layer the breaching should
be applied to. | Apply | | Close | | Cancel

e ‘Transparency’ of the design can
be altered using the slider.

e ‘Output new surface’ will create a new design layer.

‘Modify existing surface’ will make breaching changes to the selected surface.

e ‘Create breach paths as polylines on close’ by selecting this option polylines will be
generated according to the ‘Min path length’.

Bust Gilgais

‘Bust Gilgais’ breaches and evens out depressions (also known as melon holes or gilgais) in the
field while moving as little dirt as possible. It is a blend between breach depressions and fill
depressions.

e ‘Layer to drain’ lets you choose the elevations to use. It lists the layers in the Surface tab.
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‘Target cut/fill ratio’ lets you adjust how —
the design balances dirt with Bust gilgais X
compression/compaction of cuts.

e ‘Min drain slope’ sets the target slope et cut/Fill ratio g
that can be used in drain lines to drain forget culfil ratior |_1.20 5}

gilgais. The resulting slope may be less Min drein grade: 00050 (€1 %
toﬁttﬁetargetcut/ﬁll ratio. Max slope change: | 0500 [$4 % per | 3.281 [£{ft

Drainage Shape

Layer to drain: | Elevations

e ‘Max slope change’ controls the Bottom width: 200 B
smoothness of the surface. Decreasing Batter slope 10000 Bl
this can increase trafficability, but will !
increase the time it takes for the tool to

| Apply | | Close | | Cancel |

complete.

o ‘Drainage Shape’ will set an ideal cross
section for how the gilgais should be drained. The system will try to ensure that each
breach matches these settings as closely as possible. Widening the drainage shape will
also help make the design more trafficable.

Helpful tip: If you know where a lot of melon holes are, try placing a drain nearby in the design
before using this tool. This will straighten the busting lines that converge on the drain.
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k= Dam Creator

The ‘Dam creator’ tool provides a simple process of creating a dam on any selected space on
the field surface. This tool is able to make two types of dam, ‘Full Cut” dams and ‘Borrow
Pit’ Dams. So what are the differences and benefits for these dam types?

‘Full Cut’ dams take the earth needed to build the walls/banks from the center of the dam. The
advantage of this type of dam is that it maximizes the amount of water that can be stored.
The disadvantage is that the earth needs to be moved a greater distance. This makes it
better suited to smaller diameter designs.

‘Borrow Pit’ dams take the earth they need from the inner edge of the dam to build the bank.
The benefit of this style of dam is that it is faster to make and the earth needed is not
moved as far, the disadvantage is that it has less water storage capacity compared to the
full cut design.

1. Select the tool.
2. The cursor will change into a crosshair used to place the dam
centerline. Click on the map to add points to the dam outline. Y, Create FullCut Dams
Double-click the last point to finalize the outline. More points can be
inserted later.
3. After creating the outline, a pop up window will appear, showing 2 |
design options. ‘Create Full Cut Dams’ or ‘Create Borrow Pit Dams’
o The ‘Full Cut Dam’ creates a default wall with outer and inner slopes, height, and
width.
o The ‘Borrow Pit Dam’ creates a default cross section with both bank (i.e. wall) and
channel (i.e. borrow pit) slopes, heights, and widths.
4. Once you have chosen a dam type, you will be able to further customize your dam.

.Ox Create Borraw Pit Dams

Note: If you wish to edit a dam that has already been made, first switch to Guides layers in the
right panel. Next find the guidelines for the dam, select them and left-click on the ‘Edit guides’ tool.

Design
Design contains all the settings required for making dams in T3RRA Design.

e Profile’is the cross section of the dam. Multiple profiles can be added by pressing the +
button.
o When using multiple profiles, all settings are made from the “origin” point which is
a red node on one of the corners.
o A profile can be moved around the dam wall by setting its ‘Distance from start’.
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o When you have more than one profile, the dam wall blends the profiles between
them. To create a length of the dam wall with a constant cross section, put the
same profile on each side of the length. Hint: Right-click in a blank part of the cross
section plot to save and/or load a specific cross section shape.

o Template is the settings for the dam profile. By clicking the ‘Edit cross section directly’
button, the cross section can be changed manually. Simply click and drag the blue and
green markers.

o ‘Dam Bottom Height’ is the grouping of settings for the inside bottom of the dam.

o ‘Dam Bottom Shape/Drainage’ is a group of settings that also control the bottom of the
dam, however they differ from height by controlling slope and heading to allow for specific
outlet points to be made.

o ‘Surface layer’ selects which layer the dam design changes will be made to.

i
3
7

Borrow Pit Dam design Full Cut Dam design

Analyse

The analysis page displays a summary of earth moving and water capacity. This includes a
graph of water volumes by depth. The freeboard distance can be set at the bottom of the
window to adjust the water capacity details.
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Tips \
The Tips’ page provides some quick notes on the use A\
of the dam creation tool. ; \
\'\._
\\
\

@ Drains and Banks Tool

The drains and banks tool is great for planning drains, ditches, channels, and troughs. Also roads,
banks, ridges, levees and embankments. With it's 2021 update, it now lets you plan more complex
structures, like roads with drains on each side, custom contours - even whole shed pads and
feeding lots. The key attribute is that you can create these structures by extruding a cross section
design along a line (or lines). If you can describe your cross section and the path it should follow,
then you can design drains, roads, pads, borrow-pits and contours.

The tool requires three inputs - path creation, longitudinal design, and cross sections. They can be
edited independently while using this tool, although the line must exist to edit the longitudinal
design.

Create the path

When you first open the tool, define the path by clicking on the surface at its starting point, any
midpoints and finally the endpoint. The points can be dragged around to move them, and
right-clicked to delete them.

Tip: Shift+click to add points to the beginning, rather than the end.

T3RRA Design Manual Work In Progress - Page 60



Ao

Leng Sechion Emiu‘hnnllm

T3RRA
aWNe

l—l A | Dranage 7'—'-.. o [Surk
& ‘Tools: g’ “‘ﬁ E : D:r:azm

Path 1

WG

{I ch and drag o alter the position of thie point. Right-clck 1o remoe it

TR R

m 20m A0 B0
I Preview to see cul/fil uwm]
Dewgn Type
B Linear fit ) Bestfn  2hope '
Multi fit ' Marusl 0398 %[0 0,000 m
Min, Cut Eundr Mg, Cut Gundr
Reverse| [ 01 fase
= Praveaw
Note: Liwes all active surfaces, Apply F—
Cut/Fil Limits ol I'L""I
_) Calculate only cuts ) Cut/Fill Ratio Close [C] Shewe CutsFill

Iimport/Eipart ® hane

Swriaoes (3 | Bowndanes | Regons  Suides (3)
Ll Sewct  Visdoddy

e

Crease

Ecie

Crepte bhouncary from pslected Laper
Cremmier respon from sederted layes
bhnDe g e

Giean sefecisd

Copy ssieched

Artigte il

Actvite seieried

Deeaartrvints: all

Dresscirvale seieched

Deiete sincted

Carwrts i red

Show profile of selected palyime
Crmmte nnl.lgmfmm selerted palyline
Create marien sinng uelected pulyhnu
Ot seCied poiyeng

Create podytinegs fromm selecied gumu

c_mnmmmmmwﬂ-

Crate wheed etk from selected gueide

|f you've already got your path in an existing guide, then
you can create a drain from it. To do so, select the layer in
guides and then in the Layers menu, click “Create Drains
and Banks from selected guide”. The simplify option is
recommended, as it removes any points that don't
contribute to the shape of the path. This makes designing
easier and quicker to run.
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With a path chosen and shown on the map, there are two more things to design - the longitudinal
(aka long section) and the cross section. The longitudinal design defines how the elevations/depths

vary as you travel from the path’s start to end.

This shows the
longitudinal profile, Click
& drag the labels
14,B,C.etc) up and down
to the point's height.

Click anywhere along the
line to add an extra drag
handle.

This shows the excess
cutfill along the path.

This section allows you to
define the path's heights
Lsing algorithms.

Allows you reverse the

| direction of the path, and

=
I_u Tars]

Long Section | Cross Sections | Statc Path 1 = _j"l _E_l
E

= |

) Draggable labels
E i
b T T T T T v v | I
Om H0m 100m 150m 200rm

£ | 4E

i - P PP PSP AP S T
E & et m  40m S0m §0m 0m
Diesign Type Hlign Ylope sechans Gl O2pins | vE = CElow SUMace]
L} Lincar fit ) Best fit A w g * | | Apply A = e * to 000 m | Apply

) Nulti it ® Manual 2.0~ Apmy] ° L] o 000 » e

Offset depths (-ve = downj
A *ltol D *|by 000 mfﬁml
Min, Cut Guide Ma: Cut Guidt
Previes
Mote: Uses all active surfaces.
"'P‘Ph' ™ Aute

Cut/Fill Limits =
() Caloulate onby cuts Cut/Fill Raoo [ 7] Shews Cut/Fill
() Import/Export & MNaone

These let you adjust the way that we will import/export r;lrrt
Mote: They achieve this by moving the design line (green in
the above plot) up or down until balanced.

add some guides (that
don’t affect the design
algorithm)
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Edit Cross Sections

The cross sections define the shape to extrude along the chosen path, following the
elevations/depths from the long section design.

B
Long Section | Cross Sections | Stats Path 1 |+. 'Dl
‘g\..,a £.92% 2| | This shows the long
& C— 5| | section design along
o GITX 2| | with cross section
& ) % placements.

—
[5*51anrcfr:|r'.|-'l. 2084178 m | 4 | Section@208.41m
|

Termplate Path kength: 20841 m This section is to
W Desiny L Rl Fhis section cab/Rit No chainge 10m +- manage your cross

] b5 Fymimiiric [ section placements
Width: | 1000 m | ichainage).

Batters: | 100.00 3 %
[] Loek Bagters

Y
i
i

m =

These allow
you to quickly
edit narmal
drain/road
designs.

-10m

|
Edit section directhy | ] Lok at 1:1 anpect Tompiie

X

Path cemterbine o at (0.0

Click this to create

advanced designs

A game-changing feature of this tool is the ability to set multiple profiles along the path. This
allows you to create a drain that has a small width at the head and then progressively gets wider
all the way to the end. This can dramatically reduce the earthworks to implement. You can add as
many sections as you want, and it will smoothly transition between each of them.

NOTE: The green batter arrows on the end indicate that the algorithm will follow that angle until it
reaches the surface - going at a constant slope until it does.
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Working with advanced cross section designs

Path length: 20841 m
Mode properties

This section cut/fill: ~0.04 +guide line Type Mode
20m = = R : _
XY Coord 803} 125 m
Shift nods mode .
S Distance Left 813 %rﬂl
L 13.03 FULAU 5|IZ|FIE Laft =15%.61 E o
Distance Right 19,12 [ﬁl“‘l
T el ! A — e Y
10 S0.00% Stope Right 112.4 E}":
| Lire Joint Comer v
Left Line Type ® Straight

) BezierfCurved
Left Line Handle %

Right Line Type (' Straight
®) Bezier/Curved
Right Line Handle 156 @Eg

m 20rm 30m

Addleft | Add right

Delete

. g Temnplste
1 Risek 2.4 et Path centerline is at [0,0) o l ozl

Retum to standard controls |

Advanced cross section designs allow you to create custom profiles, but take a bit more work. The
plot shows where the profile is relative to the longitudinal line. The longitudinal line’s position is at
0,0 (where the two black axes meet).

A VERY important concept is that 0,0 (where the two plot axes meet) is the same elevation as the
longitudinal design (green line). If you don’t go through 0,0 then you will be effectively modifying
the long section design. This is very useful in some circumstances, however, it can bite you (if you
raise one cross section too high, it may make the drain go uphill for a bit and pool water),

How to edit advanced cross sections

You can either create your profile by just clicking and dragging the cross section line around, or

you can use the properties tab on the right. The selected node appears pink so

you can easily identify it. The clicking Ul is the same as other places you edit m

lines. Click on the line to add drag handles, right-click to remove handles, click e

and drag to move handles. _ .
e ol o

Cross sections can be linear or curved. Curved segments are created with e |
curves called beziers. To use them, click on a point and two red drag handles will
appear. The red lines with handles show the tangent of their attached node, allowing you to set up

T3RRA Design Manual Work In Progress - Page 64



T3RRA
aWNe

a smooth (or not!) transition. This feature can really help when

implementing with a T3RRA-enabled bulldozer (where you mainly S Pl
+Quide line
push across cross sections rather than longitudinally). el Y Coord

Distance Left
Adding guide lines " ﬂr"\’: Slope Left
Drestance Right
Guide lines were added so you can export guidance lines (e.g. as 50.00%
John Deere Adaptive Curves). To create guide lines, you must be in in
the advanced design tools, and then you can click the “+guide lines” button. It will add a vertical
line that you can drag left and right to position. To remove a guide line, right-click on it.

Slnp-: R-gh!

Lime laint

If you have created multiple cross sections, add guide lines to each cross section. If you have the
same number of guide lines in each cross section, they will join up. That way you can vary the
sideways position of your guide lines along the drain (e.g. for finishing). Below is an example of
going from 20m between the guide lines at the South end to 100m at the North end.

Distance from & 249.00 5] n-:.E Saction2249m [ @

Path lgngthi 248,09 m

Thes section cut/Bik o change

Hm -

I R

|

|
|
|
| | Lo
| Dlimt=
=+ Termplage e & -
|
A Mdaye |
Path carhading & at (0:00 :-.ff'.’.'..'&_-[_ o right |

Cross section batters

A concept that is a it confusing is the batters on the sides of the cross section (the green arrows).
They tell the algorithm how to join up with the existing surface. If the profile would end beneath
the surface, it will follow the angle shown in the upwards facing arrow, and the opposite is true if it
ends above the surface. This means that you can easily design a profile that is both cutting and
filling, with the batters allowing it to smoothly transition in either case.
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Working with multiple paths

The section at the top

right of the window e S
allows you to Change Long Section | Cross Sections | Stats [ Path 2 . | + E‘ﬂ
the working path.

Click the “+” button to

E
) - = Design = Elevation
add a new line. g I\L

Clicking the edit
button on the far right will let you rename and reorder the paths so you can more easily understand
which is which.

All the tabs apply to just the selected path, so when you're working on multiple paths you will need
to make sure you design all paths one by one.

NOTE: If you want to copy your current design
(both long section and profiles) you can click

“Copy To All Paths”. This copies design Long Section [{rass Siecviois)| Sems
parameters (except for manual elevation edits),

and cross sections to the other paths. 1 e e

l:: Drains & Banks

Design Type
@ [inear fit O Bestfit O Multifit =~ >'ope

. 0615 %[€
hin. Cut Guide  Max. Cu
Feverge | | Copy To ARPaths| I o0 ==dm | [ oo
\

Mote: Uses all active surf:

Cuts/Fill Limits
Calculate only cuts Cut/Fill Ratio Import/Export
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== Add contour banks / terraces

This tool is used to add contour banks/terraces. To begin creating a new set of contour
banks/terraces click on the ‘Add new contour bank / terrace set’ button in the pop-up
window. When creating contour banks/terraces a blue line in the working area is used to
control the placement, point A on the line will act as the starting point when generating the

=5

The

design lines.

Contour design window can he
broken into a top and bottom
sections:

The Top section

‘Contour bank grade (%)’ allows
you to control the slope of the
contour banks

‘Sample Distance (m)’ will control
how often T3RRA Design will look
at the lines to make sure they are
at the desired slope.

Contour banks/terraces can be set
to run to the left, right or both
sides of the start line, by selecting
the option you would like. The
‘Both’ option is linked to a
checkbox allowing you to reverse
the grade of the contour
hanks/terraces.

‘Add contour: Vertical/Horizontal
distance from A = X m’ this button
will display a distance from the
starting point. If the checkbox for
‘Starting point distances measured

Contours

1. [0.00 |m L.
2. (200 |m L
3. 400 |m L
4. 1600 |m L

Line 0 [
Line [
Line [
Edge [%] O

1. Sections | 2, Water Flow | 3. Dirt Balance | 4. Stats

Copy Sections from...

Template
Channel
Front slope:

Depth:
Width:
Back slope:!

Bank
Front slope:

Height:
Width:

Back slope:!

4 | | Section@0m

Distance from A/B line
This section cut/fill: ~1.00
10.00
0.10
2.00
10.00

# 3 3 &

10.00
0.10
2.00

[plplplep]  [<plieplie]b]

# 3 3 &
IS
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Contour bank grade (%):
Sample Distance (m):
Smoothness of calculated slope:

Direction (relative to start line):
@ Left O Right O Both

0.20@
10.00@

[ Starting point distances measured horizontally

| Add contour: Vertical distance from & =| 2.00m |

Tips

% |5

0.00 @m‘ Length [ L:-548.38m)

0m —+

10.00

Slope range
o+ Existing slope

Edit section directly [ Lock at 1:1 &

Surface layer: | Elevations (expanded)

v Template
Path centerline is at (0,0)

Preview

‘ Add Stop Line

[%\ Export

Stats...

[ Auto
Shaw Cut/Fill

Apply and
Close

Design's Cut/ffill ratio: 0.62

horizontally’ is selected this distance will rise by 50 meters horizontally each time the
button is pressed and a new line added. If the checkbox is left unselected, the distance will
rise by 2 meters vertically each time the button is pressed and a new line added. These
distances from the start point can be altered manually by clicking on the distance value
where each line appears in the box on the top left hand side and typing in the new value.
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Tab 1: Sections

There are many values to tweak on the left in the ‘Template’ section. They are broadly grouped into
two sections depending on whether they affect the channel or the bank. Try changing a few values
to see how they affect the cross section shown on the right. They include:

o Height and depth. Use these to balance cut and fill while setting your desired total contour
height. The capacity of the contour is affected by the sum of these two. A high bank
increases capacity, but can lead to water backing up onto the nearby field.

o Width. A wider contour can carry more water without it getting too fast, but this can lead
to increased earthworks in steeper areas. Increase width for sections where more water is
expected. You can adjust the width of the bank to balance cut and fill.

o Slopes. These control how quickly your contour transitions between the natural surface, the
hank, and the channel. Flatter slopes are better for trafficability, but can lead to more
earthmoving. Steeper slopes reduce earthmoving, but can cause extra erosion.

Contour cross sections can be highly customized. Just click on the [Edit section directly] button to
get started. You can even save your custom cross sections for later reuse. Simply right-click on a
clear part of the plot (when editing directly) and click Save. Load, and some other handy tools, are
also in the same menu. If you have made a mess (why not try click around and edit things for a
while) and want to go back to the simpler template based section, just click on [Return to standard
controls] in the bottom right, then click on [Set section to template] in the bottom left.

Tab 2: Water Flow

Here you can enable water flow estimates for your contours. This helps you choose an
appropriate size for your contours at various points. To start working with water flow in
contours, you should start by deciding on a rainfall event, a surface roughness, and
maximum desired water flow speed.

Note that the water flow estimates are just estimates, and can only be as good as your inputs.
There are various tips in this section to help you choose conservative values, but we take
no responsibility for breached contours
- this is just a guide to help with S el
on-site planning and adjustments. |

Once water flow is enabled, the designer
starts to calculate the accumulated
water flow. Once that is complete, a
series of water flow plots appear in
this tab, and each cross section profile
displays the estimated water level. The L L e

-400 -300 -200 -100 0

map and designer will also highlight " Dosance

- bha

- 4ha

T 2ha

Catchment Area (ha)
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sections of each contour that may breach or erode (see right).

NOTE: Contour capacity will vary depending on the shape of the contour and the prevailing
slope. A contour through very flat country will carry extra water across the uphill slope.

Tab 3: Dirt Balance

This tab displays the dirt balance along the length of the selected contour. This is very helpful
for avoiding long-distance movement of dirt. If the dirt balance has been minimized,
implementing the design with a bulldozer (or bucket scraper) can be a lot more efficient.

Tab 4: Stats

Various statistics for the current contour are displayed here. For more information, including
earthmoving, water flow details (and more), click on the ‘Stats...” button at the bottom of
the window.

Using the Contour tool

With all the functions that we've managed to put into the contours tool it can be confusing on
where to start. Here is a helpful guide on creating a contour/levee design.

Step 1: Initial setup of paths

Move the pop-up window so you can see the surface. Adjust the start line so that it is at one
end of the area you would like the contour bank and press the ‘Add contour’ button. The
first bank will be added at the start line’s Point A. Then select the contour’s direction, the
contour grade, and apply any required path smoothing to remove kinks. Contour direction is
relative to the start line, looking from A to B.
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To avoid flooding the next field over, put a stop line in the contour’s path so it drains at a
planned location:

Step 2: Refine your contour with water flow

Once you are satisfied with the contour’s location, refine your contour’s shape with the
template settings in the Sections tab. Pressing the ‘Edit section directly’ button gives you
full control over the cross section:
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Making a contour the same size along the whole length works, but involves moving a lot of dirt.
A 2/3rds reduction in dirt volume can be achieved by matching the bank capacity to the
actual water volume predicted at each point along the bank. To taper the contour, add
multiple sections with the ‘Add Section’ button and position them by editing the ‘Distance
from A/B line’ field. You can now smoothly vary the size and shape of the contour:
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To help guide your adjustments, turn on water estimates with the ‘Enable water’ button. Enter
details for a heavy rainfall event and some soil settings in the window that appears:
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Once calculations are complete, the ‘Water Flow’ tab will display all the water estimates. That
includes estimated water depth, water flow speed, and contour capacity (in terms of flow
rate and catchment area). The estimated water depth is also shown in each cross section:

262% L

0.5m

ooy ‘u._'l i

10.00% 1ds (80%) , " /
-20m0gsm 029

o |

-0.5m

10,00 L

=+ Existing
=+ Template

When editing your contour, it can be helpful to view the water plots at the same time as you
edit cross sections. To do so, click the “Pop out” button in the top right under the water
flow tab. The water plots will update as you make changes to each section.

While you are working on the water flow, remember that you can stop a contour from
breaching by increasing channel capacity or by increasing the grade (moving the water
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faster). If you do this, ensure you don't risk eroding the contour channel. You can increase
the grade for the whole contour or for

one section at a time. To change the Distance from A/B ine | 450, Mierangit A1 478.89m )
grade for one part of a contour, move This section eut/filk 221 | .

sections vertically. Do this by ‘editing
the section directly’ and entering “Shift
node mode” (see right). You may have
to move the rest of the sections up or G,
down to match so that they continueto N fesz
drain appropriately. When doing this, it - R ol
is helpful to pop out the water depth Am :;Q‘”'"*“'
plot and view the longitudinal profile at 10

the same time.

I_s|11||1-.:|

Conversely, to reduce channel erosion, you . ... ... Tomplete

e L Fath centerline is at (00

can widen your contour channel or
decrease contour grade. Bank design
must balance the competing need to slow water down (reducing channel erosion) and to
move adequate volumes of water (to avoid over-topping).

If you will be farming over (and in) your contours, check the water flows you expect with and
without standing crops. Vegetation can slow down water flow quite a bit, leading to contour
breaches.

Step 3: Save on earthmoving

When you are implementing your design, you don’t want to move dirt over long distances. This
is especially true for bulldozers, where it would take a lot of effort to move dirt from one
end of the contour to the other. Dirt imbalance at a location along the bank occurs because
grade and path smoothness considerations result in the channel being too shallow to
provide enough dirt for the bank, or so deep that there is no close location to put the dirt. It
can also occur in curved sections of the hank where the length of the channel does not
match the length of the bank. To manage this, go to the ‘Dirt Balance’ tab and press the
‘Preview pre-balance cut/fill’ button. This shows where there is unbalanced cut (red) and
fill (green). While mousing over the graph, a marker appears on the map to show its
location.
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design layer on Preview pre-balance cut/ill g Preview pre-balance design map
window close

Clear

|t can be very helpful to pop out the dirt balance graph while you adjust the sections
individually. If you do, ensure you have Auto-preview checked. To fix this without ruining
water flow, only edit the cross sections by moving them left or right. The example above
shows excessive cuts at the north end (at the right end of the graph), so the section at that
end should be moved out of the hill (to the right in the section plot below). You can easily
move a section left/right by ‘editing the section directly” and entering “Shift node mode™:

Distance from A/B line | 450,00 @n Length [ R :47859m)

I
This section cut/fillk ~2.21 5

=Dumif Ene

e Expching
-Zm + Ternplate

v Path centerbne & 2t (00}

[ Losck at 1:1 aspect
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Step 4: Guide with guidelines

To help make implementing easier, guidelines are your
friend. These can be exported as tractor auto-steer
paths. Well placed guidelines can make the finishing
pass with a bucket scraper very clean. To output
guidelines, add guideline markers to each section by
editing the section directly. The ‘add guideline’ button
is just above the “Shift node mode” button. If the
number of guidelines on two neighbouring sections
matches, the guidelines will join up with a smooth
transition (see right). If you're using a bulldozer and
want cross contour guidelines, let us know and we'll
get onto it!

Step 5: Implement!

When you are satisfied with the design, press the ‘Apply
and Close’ button at the bottom of the window to
output the design and create contour guidance lines. Export the original and design
surfaces with any desired guidelines to the format of your choice, and ...

Surface Derivatives

: Surface _— B\ o _
* Derivatives: ‘ﬁ"' “ﬁ"' @ % T ? o~ Qd &2 :

P
@ ShOW deDrESSIOnS Depressions W
This tool displays all depressions in the
selected surface or any depression that [L] Only include depressions >= 0.10 'm
meets the minimum requirements that Transparency: (]
can be set.
e ‘Only include depressions >= (X)m’ GotputsTace Hyer Close

enables the setting to limit the
depressions displayed to only those that exceed a set surface area size.
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‘Transparency’ is a slider which adjusts how clearly the depressions will be displayed in the
working area.
‘Output surface layer’ checkbox will create a design layer when you click on ‘Close’

Show directional depressions

‘Show directional depression’ allows you to select a direction and display any depressions
that would affect water flow in that specific direction that would otherwise not.

‘Direction (degrees)’ this setting will rotate the simulated water flow direction to help
isolate depressions that would affect the water flow.

‘Plane strip width’ this tools performs its calculations in strips following the set direction,
small strip sizes allow for more detailed result but take longer to process.

The Compass is a visual method for controlling the direction that is used to calculate
depressions.

‘Depressions deemed negative’” checking this option will tell the tool to display depressions
as red on the surface.
“Transparency’
controls how visible | 28 Directional Depressions X
this information will o
be Direction (degrees): 149.48 @
‘Output result |ayer’ Plane strip width: 200 m
will create an output o
layer upon closing the
tool.

‘Apply’ this button
must be pressed each
time a change is
made in order for it to
be correctly
displayed.

Depressions deemed negative

Transparency:

[+/] Output result layer ‘ Apply ‘ I Close ‘
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H) Show watershed

‘Show watersheds’ identifies the areas of the surface that will flow together to the
same exit point on a field. The working area will display the surface in a patchwork of
colours, these indicate your watersheds and what will flow out where, the specific colours
do not matter they are only to help identify individual watersheds.

‘Elevation smoothing’ provides .,
control to adjust the level of detail _
on the surface csasEiaHial @M O itk O RN
‘Segmentation method’ will select =~ e

a general water event to display =
watersheds for, the options are

Hybrid, Immersion, and Rainfall.

‘Output watersheds layer’ will

create a new design layer when

the tool is closed.
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X& Show accumulated flow layer

The accumulated flow layer shows paths where the water is most likely to pass through.
It is recommended that before using the "Show accumulated flow’ tool that the ‘Breach
depressions’ tool is used for the most accurate water flow results.

e ‘Min. drainage area’ adjusts what the minimum drainage area needs to be before the paths
will appear on the surface. The further to the left that the slider is the lower the amount of
water that needs to
pass through that
area to appear on
the field in the
working area.

e Transparency’ —
controls how the ool
flow is displayed. B Qs otioe i

° ‘Uu’[pu’[ Surfa(}e [ ] output flow paths
layer” this will tell
T3RRA Design to
create a design layer
upon closing the
tool.

e ‘Output flow paths’ which will create guidelines for the flow paths upon closing the tool.

e

T Show wetness index

"Show Wetness index” also referred to as the Hillslope Wetness Index. This tool creates a
grayscale layer of the surface that uses high contrast to show the most affected areas.
Darker areas on the field represent where the most water flow is, while lighter areas show
where there is little water flow or where the water moves away from.

o ‘Elevation smoothing’ slider that averages out the information on the field reducing or
increasing the number of peaks and valleys.

e ‘Transparency’ will change how visible the wetness index is.

e ‘Output result layer’ will create a design layer upon closing the tool.
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@ Hillslope Wetness Index

Elevation smoothing:

Transparency:

v Output result layer

ﬁ

= Show aspect

Showing aspect will change the surface to a grey-scale to highlight where the sun is hitting the
surface. North facing areas will be lighter while south facing areas will be a darker grey.

o ‘Elevation smoothing’ slider that averages out the information on the field reducing or
increasing the number of peaks and valleys.

e ‘Transparency’ controls how visible the layer is.

o ‘Output result layer’ will create an output layer upon closing the tool.

% Aspect

Elevation smoothing:
Transparency:

Output result layer
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<2 Show slope

"Show Slope” shows the severity of the slopes in the field in a colour grade. The colour
grade used is: Red shows low severity of slope and Dark Blue areas show a high severity of
slope.

o ‘Elevation smoothing” averages the information to grade how severe the slope is. The right
end of the slider is the larger area averaged of the elevation points. The left side of the
slider shifts the averaging to its smallest radius, resulting in slope severity to be more
precise in which areas it reads.

e ‘Transparency’ which controls how visible the layer is.

e ‘Output result layer’ will create a new output surface upon closing the tool.

Elevation smoothing:

Transparenc! e

Qutput result layar

2 Show directional slope

"Show Directional slope” allows you to visualize the severity of slopes going a set
direction. The severity of the slope is represented by colour with Red showing a low
severity of slope and dark Blue showing a high severity of the slope in that direction.

o ‘Direction (degrees)’, this setting allows you to set the directional slope you would like to
see on the field. This is the manual direction setting which can be used if you know exactly
which direction you wish to view.

e ‘Smooth elevation’ This slider manipulates the peaks and valleys in the present data by
taking averages of the data around each point. The further to the right the slider is the
more data is averaged resulting in fewer peaks and valleys present in the field.
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e The compass. The dark end of the compass needle represents the current directional
heading you have set. To adjust the compass click and hold on the needle and rotate it to
the direction you wish to display the slopes of.

o ‘Display back slopes as negative values’. This checkbox will display the slopes going in the
opposite direction to the compass as a negative value, causing the field to appear vastly
different.

e ‘Transparency’. This slider will change how visible the directional slope information is on
the surface of the design.

e ‘Output result layer’ tells the system to create a surface layer when the pop-up window is
closed.

e ‘Apply’. This button needs to be pressed each time you want to apply a new direction to the
field.

e Close’, this button will close the pop-up window and create a surface layer if the ‘Output
result layer’ checkbox has been selected.

[T Display back slopes as negative values

Tranaparency:

[+f] Dutput result layer Apply Close ]
[}

~= Show landscape change

Landscape change is a large scale smoothing operation for finding generalized high points.

o ‘Radius for gross landscape smooth operation’ this slider changes the radius for how far
the system will look around each point to find the average height to be displayed.

T3RRA Design Manual Work In Progress - Page 82



T3RRA
aWNe

o ‘Consider values higher than the average surface to be positive’ this option controls the
colour scheme of the display. If left unchecked high point will be coloured red and low

points will be dark blue and vice versa if the option is checked.

o ‘Perform exhaustive averaging (slow, but accurate)’ This slows down the averaging process
but more closely analyses the information for more accurate adjustments.

o ‘Transparency’ controls how visible the changes of the tool are.

EB Landscape change

Radius for gross landscape smooth aperation:
374 m

:_| Consider values higher than the average surface to be positve
[ | Perform exhaustive averaging (slow, but accurate)

Transparency:

[¥] Cutput surface layer | Close

o ‘Output surface layer’ will create a surface layer upon closing the tool.

Surface Tools - Layer Menu

e (Openoverlay images - this allows layers (such as yields, or
imagery etc) to be draped over the elevation layers. These
layers are not used in any elevation related calculations
and are denoted by the letter ‘0’ (overlay)

o Edit

o Create boundary from selected layer - this will draw a
boundary around the most outer points of the selected
surface and will populate a new boundary in the Boundary
tab

Regions | Guides (5)
Surfaces (2) | Boundaries (1)

[Layer| select Visibility
Open overlay images
Edit
Create boundary from selected layer

Create region from selected layer

Activate all
Activate selected
Deactivate all
Deactivate selected

Delete selected

Delete inactive

Import »
Export

View in Google Earth

Make selected surfaces design

Make selected surfaces overlay

Make selected surfaces base surfaces
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Create region from selected layer - this will draw a region around the most outer points of
the selected surface and will populate a new region in the Region tab
Activate all - this will activate the surface so it is now visible on the Working Area. This is
shown by the checkbox being selected.
Activate selected - this will activate the surface which you selected (shown by the tile
having a blue highlight around it) so it is now visible on the Working Area. This is shown by
the checkbox being selected.
Deactivate all - this will deactivate all surfaces
Deactivate selected - this will deactivate the surface which you currently have selected
(shown by the tile having a blue highlight around it)
Delete selected - deletes the surface you have currently have selected (shown by the tile
having a blue highlight around it)
Delete inactive - deletes all inactive surfaces (i.e. those without a tick in the checkbox)
Import >
o T3RRA Cutta elevations (*.tci) - see_Importing elevations from T3RRA Cutta (.tci)
in section: Importing and Exporting in T3RRA Design
o From existing elevation surface - see Importing a Surface from an Existing
Elevation Surface in section: Importing and Exporting in T3RRA Design
o From raw data points (Deere RCD, CSV, etc) - see Importing a Surface from Raw
Data Points in section: Importing and Exporting in T3RRA Design
View in Google Earth - this will open the selected surface in Google Earth

NOTE: You must have Google Earth installed on your PC for this to work.

Make selected surfaces design - this will change either a ‘base’ or ‘overlay’ surface/s to a
‘design’ surface and will be denoted by the letter ‘D’ on the surface/s tile

Make selected surfaces overlay - this will change either a ‘base’ or ‘design’ surface/s to a
‘overlay’ surface and will be denoted by the letter ‘0’ on the surface/s tile

Make selected surfaces base surfaces - this will change either a ‘design’ or ‘overlay’
surface/s to a ‘hase’ surface
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Boundaries Tools

When the Boundary tab is selected on the right hand side, the relevant tools will be accessed in
two different areas. Firstly, on the menu bar (this changes depending on which layer type is
selected) and is explained below in Boundary Design Tools and secondly, in the Layer menu
on the selected tab and is explained in Boundaries Tools - [ayer Menu

Boundaries Design Tools

Boundaries: D+ b g‘ ﬁb /// D@ _

The Boundary tools available in T3RRA Design create boundaries that are used to limit where
field designs will affect. In order to apply any design to elevation data in T3RRA Design
they must first have a Boundary.

There are 5 Boundary tools available in T3RRA Design, Point to Point Creation, Boundary Edit,
Slice Boundaries, Multiple Cut lines and Open boundaries in Google Earth.

(N Point to Point Creation

‘Point to Point Creation’ changes the mouse icon to
a cross. While in this mode, clicking anywhere in
the working area will add a point. These points
anchor the line that appears on the screen with the
|ast point and the first point connecting
automatically to create a closed boundary line at all
times. In order to complete and add the boundary to
the layer selection, double click on the last desired
point.
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Eﬁ‘ Boundary Edit

‘Boundary Edit’ displays a series of nodes along
existing boundary lines. By left clicking and
holding on these nodes the boundary lines are
able to be moved anywhere.

When hovering over a line, a blue node will appear
half way between the 2 gray nodes along that
line. By clicking on a blue node it will become
anew gray node and adding a new point from which the boundary line can be adjusted.

(1 Slice Boundaries

‘Slice Boundaries’ is used to split pre-existing boundaries into smaller areas. Once this tool has
been selected your mouse cursor will change to a pencil while it is in the working area. To
add a line to a boundary
click on the outside of the
line to create a starting
point, from this point
wherever you move your
mouse a red dotted line will
be connected showing
where the new boundary
line will be created. Clicking
on the working area again
will place the new boundary
line along the red dotted line that intersects with 2 other boundary lines.

/" Multiple Cut Lines

The ‘Multiple Cut Lines’ tool provides a
way of creating equally spaced
boundary lines across already existing
boundaries.
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When the tool is selected a pop-up window and a selection tool will appear in the working area.

In order to place the cut lines use the selection tool. The yellow square in the center of the
selection tool controls the position of the lines, the yellow triangles on either side of the
selection tool control the width of separation between the lines and the yellow circle
controls the length of the selection tool as well as the rotation of the selection tool.

by Open Boundaries in Google Earth

‘Open Boundaries in
Google Earth’ allows you

to export your boundary
lines to Google earth.

When the tool has been _
selected to export your

boundary lines a pop-up

Name your layer:

window will appear. In _ -
this pOp-Up window the |T3RRA Design Boundaries |
layer that is being | ok | | cancel |
exported can be named.

Once the layer has been
named press ‘0K’ and the
layer will be exported to
Google Earth.

Boundaries Tools - Layer Menu

Open

Create

Edit

Create boundary from selected layer

Create region from selected layer - this will draw a region

around the most outer points of the selected surface and will

populate a new region in the Region tab

o Merge selected - (ensuring you have 2 or more boundaries
selected) this will create a combined boundary, removing the
initial boundaries

e (lean Selected

Regions Guides (5)
Surfaces (2) | Boundaries (2)

| Layer | Select Visibility

Open

Create

Create region from selected layer

Clean selected
Copy selected
Activate all
Activate selected
Deactivate all
Deactivate selected

Delete selected

Import
Export

View in Google Earth
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Copy selected - this will duplicate the selected boundary
Activate all - this will activate all the boundaries so they are visible on the Working Area.
This is shown by the checkbox being selected.
Activate selected - this will activate the boundary which is selected (shown by the tile
having a blue highlight around it) so it is now visible on the Working Area. This is shown by
the checkbox being selected.
Deactivate all - this will deactivate all boundaries
Deactivate selected - this will deactivate the boundary which you currently have selected
(shown by the tile having a blue highlight around it)
Delete selected - deletes the boundary that is selected (shown by the tile having a blue
highlight around it)
Delete inactive - deletes all inactive surfaces (i.e. those without a tick in the checkbox)
Import >

o |mport Shapefile

o [mport KML

o |Import Multiplane Boundary

o Import DXF points/linework
Export >

o Export selected to Shapefile

o Export selected to KML

o Export selected to Text Columns (CSV, TSV, etc)
View in Google Earth - this will open the selected surface in Google Earth

NOTE: You must have Google Earth installed on your PC for this to work.
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Regions Tools

When the Regions tab is selected on the right hand side, the relevant tools will be accessed in
two different areas. Firstly, on the menu bar (this changes depending on which layer type is
selected) and is explained below in Regions Design Tools and secondly, in the Layer menu
on the selected tab and is explained in Regions Tools - Layer Menu

Regions Design Tools

ERegions:T::-'- I:_f; I:I: f"f;{:‘j

=

Regions are a method of dividing a field or alike. Regions allow you to work with multiple fields
separately in one project.

D* Point-to-point region creation

This tool lets you create custom regions.
When using the creation tool, the cursor
will change into a cross. Each left-click
will add another corner to the closed
region space. To finish adding points to
the region, double-click where you would
like the final point to be.

Eﬁ’ Edit region nodes and edges

This tool is used to make changes to a region
once it has been created.

To use this tool ensure that a region layer is selected
in the layers display on the right of the screen.
Once the layer is selected and the tool is
selected, red dots will appear at each corner of
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the region. Each of the red dots is a node that can be used to adjust the shape of the region
by left-clicking and holding to drag the point to a new location.

When the cursor is over a region line, a blue dot will appear. Left-clicking on a blue dot will
insert a new node, at which time it will turn red and become editable.

0 Split Region using Cut line
The “Cut line’ tool allows you to place a line to
split a single region into two. This is useful

when you wish to create different designs on
different sections of the surface.

To use this tool ensure that you have an existing
region selected in the layer selection.

To make a cut, left-click at one end of where you would like to cut and move the cursor to the
other side. A red dotted line will appear along where the line will be cut. Make sure that
this line intersects with at least two other lines of the existing region. When you are sure
about the placement of the line left-click on the ending point to cut the region. Right-click
to cancel the region cut.

/// Region Multi-Slicer

The region multi slicer makes it easy to slice a region into many smaller ones. All cuts
made with this tool will follow the same direction and will be parallel to each other.

To use this tool, make sure that you have a region layer selected.
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Strip width: 28_20:| m  Strip count: 10
Segment length: 323“50I m

Total width: 28203 m Total length: 32360 m

Bearing: [ 1123) [ East/West | [ North/South |

Apply | Cancel |

When the tool is selected, it will automatically generate a set of lines. The yellow anchor points
can be used to edit the size and positioning of the slices.

‘Strip width'’. This value controls how far apart each line is. This option allows for precise

control over the width.

“Strip count’. This value controls the number of lines that will be used to cut the field.

"Segment length’. This option controls the length of the lines used to cut the region.

Adjusting the value here has the same effect as moving the yellow circle anchor.

o ‘Total width’ and Total length’ are not adjustable options - they are for display only, and are
calculated from ‘Strip width’ and ‘Segment length’.

e ‘Bearing’. This option is a more precise method of adjusting the heading of the lines. The

‘East/West’ and ‘North/South’ buttons set the heading to follow directly along those

directions.

Once all changes have been made, press the ‘Apply’ button to make the cuts on the selected
regions, or the ‘Cancel button to back out of this tool.
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ONe
Surfaces (2) | Boundaries (1)

Regions Tool - Layer Menu A

e (pen e

e Create> e

o Create from saved surface e
o Create from selected surface

o (Create from saved boundary e sakoc

o Create from selected boun Clean selected

° Edlt Copy selected

e (reate boundary from selected layer Actaest

o Create region from selected layer - this will draw a g
region around the most outer points of the selected ARty
surface and will populate a new region in the Region o p——
tab '

o Merge selected - (ensuring you have 2 or more import
boundaries selected) this will create a combined Export
boundary, removing the initial boundaries e

e (lean Selected

e (Copy selected - this will duplicate the selected boundary

o Activate all - this will activate all the boundaries so they are visible on the Working Area.
This is shown by the checkbox being selected.

o Activate selected - this will activate the boundary which is selected (shown by the tile
having a blue highlight around it) so it is now visible on the Working Area. This is shown by
the checkbox being selected.

o Deactivate all - this will deactivate all boundaries

o Deactivate selected - this will deactivate the boundary which you currently have selected
(shown by the tile having a blue highlight around it)

o [Delete selected - deletes the boundary that is selected (shown by the tile having a blue
highlight around it)

o [elete inactive - deletes all inactive surfaces (i.e. those without a tick in the checkbox)

e |mport>

o |mport Shapefile

o [mport KML

o |Import Multiplane Boundary

o Import DXF points/linework
e Export>

o Export selected to Shapefile
o Export selected to KML
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o Export selected to Text Columns (CSV, TSV, etc)
o View in Google Earth - this will open the selected surface in Google Earth

NOTE: You must have Google Earth installed on your PC for this to work.

Guides Tools

Guides

The “Guides’ layers allow extra information to be displayed on the field in the working area. This
information can include elevation grids, flow directions, and contour lines.

There are many tools available in the guides toolbar to help manage and quantify the elevations
on the field.

% Edit Guide
The ‘Edit guide’ tool allows you to make changes to any other guide information set on the
field after the initial window has been closed. To use this tool, the appropriate layer needs
to be selected in the layers panel on the right side of the screen. After the correct guide

layer has been selected, pressing the ‘Edit Guide” button will reopen the window that
appeared when the layer was first made.

"% Point label

This tool lets you place labels Label: [Label Tt size: [0
on a field as reference points, or
simply to remind you of points
you may need to watch out for
or pay closer attention to.
Selecting the tool will change
the mouse cursor to a cross,
then clicking in the working
area will create a point and

Symbol; . v Symbol size: |6 ¥

Color: _E

[[] Use this label as sub-region title

Easting: |447016.094 Northing: |6682166.519

Value: 115,181 m [ ] Lock value

Copy to clipboard | Close
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open a pop-up window, allowing you to change its properties:

e ‘Label’ The text in this box will be displayed on the map. The size of the text can be altered
by using the ‘Text size” option on its right.

e ‘Symbol’ allows you to change the symbol or shape that is used for the point.

e ‘Symbol size’ allows you to make the symbol larger or smaller.

e ‘(Color’ allows you to change the color of the label marker that is placed on the field in the
working area.

o ‘Use this label as sub-region title’ will use the label as the title for the region it is in if
multiple regions are present.

e Fasting and Northing show the coordinates of where the point label has been placed. It can
be changed using the yellow point on the marker or by inputting new values here.

e 'Value’ option displays the elevation or height of the label and can be changed by entering a
new value here. If you enter a custom value, ensure you lock it with the neighboring option.

e ‘Lock value’ locks the value that has been set in the ‘value’ field so that it will not update to
the currently active surface. Unlocking a point label is a way to get a surface elevation of
cut/fill value at a specific point.

e (licking on the ‘Copy to clipboard’ button will copy the name of the label and its
coordinates so they can be used elsewhere.

When creating a label, if you have a label layer selected on the right, it will be added to that
layer (otherwise it will create a new layer for it).

&<, Line Label guide

The “Line Label guide’ tool allows you to select two points anywhere on the field and
display the distance between them with a label attached. When the tool has been selected
the cursor will change into a cross.

Line Label

Label: :Label . Text size: | 12 ¥ |

Line style: _B .

[ 1 Arrow at start [ Arrow at end

Show distance

v
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‘Label’ This is the title of the line that has just been created. The label’s text size can be

changed using the ‘Text size” option to its right. This text size option will only affect the

title on the guide, it will not increase the size of the text in the measurement.

e ‘Line style’. The left drop down menu allows you to change the color of the line, the right
drop down menu allows you to select the thickness of the line.

e ‘Arrow at start’ and ‘Arrow at end’ allow you to add arrows to the start and end of the line.

e ‘Show distance’ adds a secondary, thinner, line below the original line that displays the

distance covered by the line. This option is turned on by default.

(=) Circle guide

The ‘Circle guide’ tool will display the radius and total area covered by the set circle. To
use the tool, left click where you want the center of the circle to be and drag the mouse
until the circle is at the desired size.

Circle

Line style: _JZI —

The option on the left in the window allows you to select the color of the circle. The option on
the right allows you to select the thickness of the line.

At the center point of the circle, the total surface area of the circle is displayed. Starting from
the same central point, a radius line will be placed showing the distance of the center to
the edge of the circle.
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— Strip/Corridor guide

The "Strip/Corridor guide’ tool creates 2 parallel lines. When selecting this tool, click on
the field where you would like the center point of 1 line to be, then drag away from this
point to create a set of parallel lines.

Parallel Lines

Width: | 89.00] m Length:| 44252/ m

e stye: N~ -
Arrow at start

o ‘'Width’ displays the current width set between the lines. The distance between the lines
can be adjusted by typing a new value here or by moving the yellow triangle on the surface.

o ‘Length’. Changing the length value adjusts the size of both lines. The length may also be
adjusted by dragging the yellow circle point that is at the end of one of the lines.

o ‘Line style’. The left menu allows you to select the color of the lines, while the right menu
lets you select line thickness.

e ‘Arrow at start’ and ‘Arrow at end’. Selecting either of these checkboxes will create arrows
at their respective location on the lines.

[+ Polyline measurement

The “Polyline measurement’ tool is used to create a guide line with multiple segments.
The length of individual segments and the angles between them may also be displayed.
When the tool has been selected, the cursor will change into a cross. Left clicking
anywhere in the working area will place the first point, and clicking again will place
segments. To finish adding segments, double click on the final point. Double clicking will
open a window where settings for the polyline can be changed. The points of the polyline
can be adjusted by dragging the yellow squares.
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Polyline

Line style:

14

Smooth: .

0 = : |
Use real unit width: |2.00 'm Simplify: | |

Show distances Show angles [ | Show slopes

Point count 4 |

e ‘Line style’. The left drop down menu lets you set the line color, while the right drop down
menu lets you set line thickness.

o ‘Smooth’ will take the points that are available and adjust them to a more direct path with
fewer corners. When the slider is all the way to the right, the points of the measurement
guide will be lined up in a straight line.

o ‘Simplify’ will remove points along the polyline while attempting to follow the original path
as closely as possible. This is most visible when the slider is used on polylines that make
small direction adjustments.

e ‘Use real unit width” when selected will disable the right drop down menu of ‘Line style” and
set the width to the value on the right of the checkbox. When using this option, the line
thickness is no longer linked to pixels and will increase in size as the zoom level increases.

o ‘Show distances’ will display the length of each segment of the polyline.

o ‘Show angles’ will display the inside angles of each joint between segments.

“Show slopes’ will display the overall grade of each segment as a percentage.

(> Polygon measurement

The Polygon measurement’ tool measures the length of the sides as well as total space
covered inside a chosen shape. When selecting the tool, the cursor will change into a cross.
Clicking on the working area will place a point - continue clicking where you would like
points to be placed, and double click on the final point to finish placement. The yellow
squares can then be dragged around to adjust the shape.
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Fill style: " El :-Soiid v|

Show distances @ outside O inside

W

Show angles Show area

Text size: 12 ¥ :

‘Line style’. The left drop down menu lets you select the color of the guidelines. The right
drop down menu allows you to change the thickness of the guidelines.

‘Fill style’. The left drop down menu allows you to set the color of the shape’s fill. The right
drop down menu provides 3 options as to how the closed shape will be filled: a solid color, a
hatched pattern, or a dotted pattern.

‘Show distances’. Sets whether the distance of each segment is displayed. There are two
options to the right to control where they are displayed.

"Show angles’ will toggle on and off the display of angles between each segment of the
polygon guide.

‘Show area’. This option toggles on and off the value shown at the center of the polygon.
Text size’ controls the text size of the total area covered - it does not affect the text size of
the distances and angles.

7/ ABlines

The 'AB lines’ tool creates a pattern of guides along the working area. When using the
tool, the cursor will change into a cross. Click on two points in the working area to create
an AB line.

AB Lines

Point A latitude: -29.933946 Point A longitude: 146.449288
Point B latitude: -29990717|  Point B longitude: | 146.452809)
Heading: _167.1] (0-360 deg,) Swath width: | 100.00/ m

Swath distance format: @ Distance O +/- O L/R O None

tine style: ([N ~] | — -
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‘Point A latitude’, ‘Point A longitude’, ‘Point B latitude’, and Point B longitude’ are used to

precisely control the position of Point A and Point B.

o ‘Heading’. The value in the heading setting controls the direction of the guidelines. The
value displayed is the heading in degrees of Point B from Point A.

e ‘Swath width’ controls how far apart the lines are. The two dotted lines (on either side of
the central line) show the reach of the implement (its swath width) as it travels down the
first/central AB line. Thes can be used to position the first line relative to a boundary, or
other feature.

o ‘Swath distance format’. This setting changes how the line labels are displayed.

o ‘Distance™ will [abel each line as how many meters it is from the center line.

o “+/-"-will label each line as a number and whether it is positive or negative.

o ‘L/R’- will label each line a number and either L or R depending on which side of
the center line it is.

o ‘None’ will remove all labels from the AB lines.

e ‘Line style’. The left drop down menu will let you set the color of the guidelines, while the

right drop down menu will let you set the thickness of the guidelines.

1255 Elevations Guide
The ‘Elevations guide’ imposes a grid design on a field in the working area and displays
the elevation of points at each junction on the grid. When using this tool the cursor will
become a crossClicking on the working area in the desired center point will create a grid.
The grid size and position can be manipulated by using the yellow anchors.

A

Grid cell size: 100.0| m Alignment angle: | 89.9039| deg

115,1m

Text size: | g ¥ Decimal places: | 1)

1151m 115,1m

® Show elevations @ Use topmost layer
() Show offsets from mean elevation (O Use selected layer(s)
© Show offsets from center elevation O Use all surface layers

Display units
Auto-update with surface changes Export to CSV ‘ l Close J

o ‘Grid cell size’. This option controls the size of the grid. Setting the size to 100m will result
in each junction being 100 meters away from its neighbors.
o ‘Alignment angle’ is a method of rotating the grid.
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e ‘Text size’. This option is a drop down menu that allows you to change the text size of the
values on the grid.

e ‘Decimal places’. Sets how many decimal places will be visible on the grid values.

o ‘Show elevation’, "Show offsets from mean elevation’, and "Show offsets from center
elevation’. These options will adjust what data is present on the grid.

e ‘Use topmost layer’, ‘Use selected layer(s)’, and ‘Use all surface layers’ control which
surface layer is used to calculate the elevation points on the grid.

o ‘Display units’. By selecting this checkbox, the measurement units (meters, feet) will be
shown on each value on the grid.

e ‘Auto-update surface changes’. By selecting this checkbox the grid will automatically
update the displayed values when surface layers are changed.

e The grid is able to be exported into a CSV format by pressing the ‘Export to CSV’ button in
the bottom right of the pop-up window.

%% Flow direction guide

The ‘Flow direction’ guides creates a grid on the field with arrows at each junction that
point in the direction that water is expected to flow. When the tool is selected the cursor
will change into a cross, and left-clicking in the working area will create a grid centered
where you clicked.

Flow Directions Grid

Grid cell size: | 50.0/ m Grid alignment angle: | 90.0000| deg

Slope calculation area:
e syt I~
V] Auto-update with surface changes

_:...._
T oo | S

o ‘(rid cell size’. Adjusting this value will make the individual squares of the grid larger or
smaller.

e ‘(rid alignment angle’. This option allows you to change the direction of the grid.The
direction is set as the position of the yellow circle in relation to the yellow square.

o ‘Slope calculation area’. The further to the right that the slider is, the larger the area that
T3RRA Design takes as a sample to find the water flow direction.

W
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e ‘Line style’. The left drop down allows you to change the color of the arrows on the field.
The drop down menu on the right allows you to adjust the thickness of the arrows.

e ‘Auto-update with surface changes’. When this option is selected, the grid will
automatically update when the surface layer changes.

2 Contour lines

The “Contour lines’ tool allows for the automatic creation of contour lines on the selected
field. When the tool is selected, the cursor will change into a cross. Left-clicking on the
desired field will generate contour lines and open a pop-up window that allows you to make
changes to the contour lines.

Contour Lines

Reference elevation: 115174 m Smooth contours:

Vertical interval: 0.050| m Simplify contours:
Show labels: O contour altitudes  Min. contour size: 2000 m
O line numbers Lines: 19

® no labels Points: 7172

Contour line style: _E _—

10 v

Labels size:

_ Close |

o ‘Reference elevation’ allows you to change the starting elevation that contours fan out
from.

o ‘Vertical interval’ is used to change the elevation change between contour lines.

e ‘Smooth contours’. This slider will smooth out sharp turns in the lines. The further to the
right the slider is, the more smoothed the contour lines will be.

o ‘Simplify contours’. This slider adjusts how complex the lines are. The further to the right
the slider is, the straighter the lines will become.

o ‘Show labels’. On the left is a set of 3 choices: ‘contour altitudes’, ‘line numbers’, and ‘no
labels’. These options control the display of information on each contour line. ‘Contour
altitudes’ will display the elevation of each contour line. The second choice, ‘line numbers’,
will display the number of each line, starting from the reference line. The final choice is no
labels’, this choice will leave the lines unlabeled.

e ‘Min. contour size’ is the minimum length contour lines placed on the field.

o The ‘Contour line size’ options are a set of drop down menus. The left menu lets you select
the colour of the contour line, and the right menu lets you choose line thickness.

o ‘Label size’ will adjust the size of text along the contour lines.
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_\] Slope Indicator

The “Slope Indicator’ tool is used to measure the slope of a particular area. When the tool
is selected the cursor will change into a cross. Once a point has been selected, slope
indicators will appear on the field and a pop-up window will be opened. The slope indicators
can be manipulated on the field by using the yellow anchor points.

Slope Indicator

Base point |atitude: -29.990718 Longitude: | 146.451038|

Main angle: 0,00003 deg Area size: 0.010] ha
Sideangle: 270 deg Max. slope angle: 328 deg
Reference line length: 200/ m [] Lock reference line length

Show line lengths proportional to line slopes
[] Hide primary and secondary direction lines when not editing

Main/side line style: _E
Max. slope line style: _EJ — |

[] Separate indicator from reference paint

W

[] use this slope for print output

Auto-update with surface changes
Close

‘Base point latitude” and ‘Longitude’. These options control the position of the indicator on
the field. They can be manually changed by typing a new values in the boxes. These
changes take immediate effect.

‘Main angle’ This option controls the direction of the main direction line. The line changes
size proportionally to the slope of the area. Until the settings have been finalized, the
direction of the main line can be modified with the yellow circle anchor.

‘Area size’. This option controls the sample area of the slope indicator. The elevations within
the sample area are read to determine the displayed slope. Increasing the value displayed
in the box reads more elevations and provides a more averaged slope measurement.
Decreasing the area size gives a more specific and local slope measurement.

‘Side angle’ and ‘Max. slope angle’ cannot be changed within the window and only display
the directions of the lines based on the position and orientation of the guide.

‘Reference line length’ allows you to change the maximum length of the slope indicators.
‘Lock reference line length’. When selected, this locks the reference line to its current
length while dragging the yellow circle.

‘Show line lengths proportional to line slopes’. When selected, the lines will adjust in length
to match the slope of the selected area. They will not exceed the reference line length.
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e ‘Hide primary and secondary direction lines when not editing’, selecting this option will
hide the main direction line and the secondary direction line once all settings have been
finalized and the window has been closed.

o ‘Main/side line style’ the left drop down menu lets you select the color of the two slope
lines at 90° to each other. The right drop down menu lets you select their thickness.

e ‘Max. slope line style’ the left drop down menu allows you to change the color of the
maximum slope line. The right drop down menu allows you to change the thickness of the
slope line.

o ‘Separate indicator from reference point’. This option allows you to move the indicator to
another location while still using the same reference point. Once settings have been
finalized the reference point and area will be invisible.

e ‘Use this slope for print output’. This option selects this slope for printing output.

e ‘Auto-update with the surface changes’. This check box will cause the slope indicator to
adjust the displayed values depending on the top most layer in the surface selection.

WY Create flow paths

The ‘Create flow paths’ tool is used to create a display of the likely water paths present in
a field. When the tool is selected, the cursor will change into a cross. Left click on a field to
display the flow paths. Once a field has been selected, it will be populated with flow lines
and a pop-up window will be opened.

Elevation smoathing:

Seed points grid size: | 50.000/ m

Flow paths style: _IZI '

Apply

o ‘Elevation smoothing’. This option is a slider that controls the smoothing of the elevation
hefore creating the flow lines. The further to the right that the slider is, the more
imperfections are taken out of the flow paths, creating straighter paths.
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e ‘Seed points grid size’ controls the size of the grid that is used to take samples for flow
paths. Setting a higher value here makes a larger grid and hence takes fewer samples.

o ‘Flow path style’is a set of 2 drop down menus. The left drop down menu sets the color of
the flow paths, by default this is set to black. The right drop down menu sets the thickness
of the flow paths, by default this is set to the thinnest option.

In order for any changes made in the window to be reflected in the field you need to press the
‘Apply’ button at the bottom of the window. Once all desired changes have been made press
the ‘Close’ button on the window to save all changes.
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Troubleshooting Guide

Antivirus Software

Software fails to start

Symptoms:
T3RRA Design will not start, or the T3RRA Design update does not work after downloading a
new version.

Cause
jababat = =
BdIGuard’," ®  Quarantine ©r uvpdate L3 semngs [ — W X
llllll riginal locati When Details
i
mplattfu@bigpond.net.au Shop Support
TR — T ™ = .
Solutions:

It may be necessary to switch to another version of antivirus software, or to add an exclusion
for the T3RRA Design folder. Most reputable antivirus software providers provide
instructions on how to add an exclusion.
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Follow the below links if you use one of these antivirus software:

e Bullguard
e AVG AntiVirus

e Malwarebytes

When adding an exclusion, the path to exclude is:
C:\Users\YourUserName\AppData\Local\T3RRADesign2

NOTE: Be sure to replace “YouruserName” with your actual user name.

Importing

DXF import failure

Symptoms:
DXF file import is unsuccessful. Error message "DXF linework import has failed: Object
reference not set to an instance of an object” when importing DXF into T3D.

Cause: " i Il
DWG saved as R12/LT2 DXEF. T - o8
Solutions: ;“:‘m“:u 5. '
DWG saved as 2013 DXF. e

| Fleseftype: | AroCAD 2013 Drawing [-dwg) 2] Cancel |
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DXF import into T3RRA Design

Symptoms
Importing a DXF data into T3RRA Design and when you use the Google earth tool to view the

surface it’s not in the correct location.

Cause
There could be many factors that impact importing third party data into T3RRA Design, the most

common is the data not being in the correct coordinates format or datum. This data can also be in
a localized local format. Always ask for data in latitude and longitude or UTM.

Solution
Below is a template that can be used for customers wanting to import DXF or third party data into

T3RRA Design.

Original surface survey in DXF 3D Faces,
Design surface in DXF 3D Faces,
Any earthworks control points, markers and feature points in DXF (these require lat long
and elevations)
Any design linework you would like displayed over the map, in DXF also, (things like the top
of batters bottom of batters, change of grade and roads etc,)
Any lines you would like made into guidance lines for steering also in DXF,
o With all of these, we need to know the alignment or any "localised" information
please.

NOTE: It is preferential that anyone using JD iGrade have a surveyor provide them with a pegged
location to place their base over. Enter the lat and long of the peg manually as an absolute base.

Removing Bad Data Points

Symptoms:
e |mported field elevation data is all one colour.

e Field is also not centre on the import screen.
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Import buttons are enabled once a surface is present | o=

Cause:

There are many ways in which a system can collect bad data points. This could be due to the
tractor being parked at the shed with the linkage down. When the tractor is started and the
recording source is set to the linkage. The system will record a couple of points at the location. You
will not know that at the time but when you bring that data into T3RRA Design you will see the
field to be all one colour.

Solution:
1) Import elevation data for the John Deere display into T3RRA Design and edit the bad

points.
2) It you are using the John Deere Operation Center and have documented a task you could

also use our on-line tool T3RRA 3D.
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Q Import delimited text data —

This window shows a preview of the data you are loading. Make sure the you select the correct columns for latitude and longitude,
Import cpticns:

Field delimiter: ) Tab () Semicolon @ Comma () Space || Treat consecutive delimiters as one

# Lines to ignore: |0

Data file has header row
Data file contains coordinates

Coordinate system: (® WGS 84 Lat/long (O UTM () Other

Farmat

(®) Decimal Degrees () Decimal Minutes () Degrees, Minutes, Seconds ) Topcon style D.MS

Hemisphere indicator

@ Latitude sign (+/-) ) Prepended ENW.S O Appended ENW,S O ENW,S from column

Longitude

Elevation column

Longitude v

Elevation units | Meters o

Latitude

< longitude <= Llatitude <= Altitude (m)

Latitude

Select the column of data that represents elevation values

List of elevation values to exclude (comma separated). ie -9999:

Longitude
128.717108169861

Latitude
-15.6435959358919

Altitude (m)
36.58688278

128717110195882

-15.6435969872614

36.88988278

128717116264433

-15.643600131465

36.89200388

128717118407769

-15.6436010808052

36.89000388

128,717120475034

-15.6436021502305

36.88400388

128717126529736

-15.6436052699615

3688800388

128.717128616785

-15.6426062172864

3685600388

128.717130687786

-15.6436071507425

3685600388

128.717136815727

-15.6436100138434

3689500388

128.717138017879

-15.6436110020453

3689400388

128.717140097202

-15.6436120322571

36.80400388

CK

Cancel

Raw point data surface and import window will open.
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If you look hard enough you will see bad data points.
e QoL R8s, D e ol ol B L B, ||

Pty ehszs rarge 3570 34 ey O

Import battons ars onablod once a surface i present |Cow
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You can use the “Points selection Tools” to select the unwanted points.

: arch radiusim) _ ™% Pathwidth{m) &
£ Box Selection |
" Circle Selection

Point-to-Point Selection
Freehand Selection

%% Magic Wand Selection

Once you have, select the bad points, use the “Trash” icon to remove the points.

Lm ) [50_ e 100
L fue _FNB cearchradiusim)  _ (™5 Path width {m)

Once the bad points have been removed your map should look like the screenshot below.

Impors butions are enabled onca » surface is present |Ci
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Printing to PDF - Logo is upside down

Symptoms:

The logo is upside down when a design is printed to PDF.
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SCALE: 1in 3354

SURVEYED: T3RRA
DESIGMED: Mone
CHECKED: T3ERA

J L
138B8Y

Unit 4. 18 Roda Court
Toowoomba, QLD Australia
PHOME +61 415 960 739

CLIENT:

Everyone

PROJECT:
Manual Updates

DESCRIPTIOI

Cause:

Using a custom Print to PDF tool. For example, Foxit PDF Printer.

Solutions:

Use the built in “Microsoft Print to PDF” printer. This one is free and provided with Windows.

SCALE: 1in 3354

SURVEYED: T3RRA
DESIGMED: Mone
CHECKED: T3ERA

T3RRA
WY

Unit 4. 18 Roda Court
Toowoomba, QLD Australia
PHOME +61 415 960 739

CLIENT:

Everyone

PROJECT:
Manual Updates

DESCRIPTIOI
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Viewing in Google Earth - Google e

Earth does not open e
Symptoms: st
Clicking the Show in Google Earth button doesn’t work.

Opening Google Farth doesn’t work either. St gl 0
Cause: Cancal
Google Earth has stalled and is not responding.

Solutions: g by
Restart your computer. Shaw the destton
To avoid having to restart your computer, open Task Tsk Marioges

Manager by right-clicking a blank part of the
taskbar (usually at the bottom of the screen)
and selecting Task Manager.

Then, under the Processes tab, right-click on
Google Earth and choose End task. Then Google
Earth should start up successfully.

3 Taskbar s=ttings

@ BT ~ o

% Task Manager - O X
File Opticns View
Processes Peformance App history | Startup Users Detads Services
5% ¥ 60% 1% 0% 0%
Mame Status CRU Memaory Dk Metwork PU | G
§ Google Chrome (14) 0% 1,147 MB 0.2 MBfs 0 Mbps 1
D{: Micresoft Visual Studio 2009 (32 b.. 0% 7.1 MB 0 MBy's 0 Mbps D3
[25] ServiceHub. RoshynCodefnalysiss.., 0% 3726MB MBS 0 Mbps 0%
¢ == Google Earth Expand ji4 MB 0 MB/s 0 Mbps (e
BB Everything End task LIA ME 0 MB/s 0 Mbps ok
e Hi #
[¥ Antimalware Service Executable il 51MB OOMB/As 0 Mbps o
Provide feedback
) googledrivesync.exe 122 MB 01 MBS 0 Mbps 0
; Drebug
E Dropbox (32 bit) Creste durmp file J1.1 MB 01 MBS 0 Mbgps i3
|L;‘:' paint.net (3 Bkt detais g1.7T MB 0 MB/s 0 Mbps [
L
< =Rt Fw Open file location e 3y B i,
Search online
Fewer details Properties End task
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Updating Software

Downloading updates seems to have no effect

Symptoms:
T3RRA Design indicates that a new version is available. You successfully download the new
version using the normal “File\Check for updates” method. However, upon restarting software
T3RRA Design has the same version number as before and is indicating that a new version is
available.

Cause:
T3RRA Design is not started directly. To start it you normally must execute a bootstrapping

program which in turns selects the version of T3RRA Design to run. If your shortcut is linked to
specific version of the software, this version will always run, even where there are newer versions
installed on your machine.

Solution:
Browse to ‘C:\Users\<your user>\AppData\Local\T3RRA\T3RRA Design’. There you should find a

file named “T3D Bootstrap.exe’. Depending on your settings, the file extension may or may not
show. Note that “C:\Users\<your user>\AppData’ is normally a hidden folder so you may have to
reveal it using “Show hidden file and folders” on your system. Alternatively, simply type in the path
in the Windows Explorer location bar. ‘T3D Bootstrap.exe’ is the file you want to execute whenever
you run T3RRA Design (v0.1). Create a shortcut on your desktop pointing to this file.
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Contour Designer

Contour has no batter

Symptoms:
A contour is designed, but the cut/fill stops without a batter. In a cut/fill overlay, it will go from

(e.g.) bright pink to gray without a transition.

e

Cause:
The batter is not steep enough. In the case shown above, the hill and the batter both had ~5%

slope. That's why it tried to cut forever.

Solution:
Add a section or two around the problem location to avoid changing the whole contour. Then for

the affected section, increase the batter a bit above the prevailing slope. Preview cut/fill to verify.
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